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Introduction 

iMindQ® is a dynamic and exciting mind mapping software tool for creative thinking, 

brainstorming, visualizing ideas, presenting them to other or putting ideas into action. 

iMindQ® helps you map out any information the way you want, also you can improve your 

memorization, increase productivity and creativity. It is great for solving problems easier, 

improving communication and making plans more quickly and creatively. 

By its smooth usability and highly interactive interface it really saves time, energy and effort 

and improves every aspect of your work. iMindQ® allows users to capture all important 

information on a simple, easy-to-use, cross-platform. Follow your ideas and intuitively create 

friendly mind maps.  

iMindQ® guides you to clarify your thinking. The flow of your thoughts creates worthy and 

valuable never-ending story. iMindQ® helps you make your story streamlined in an intuitive 

and powerful mind map and stimulate your visual thinking.  

iMindQ® lets you create mind maps, make a good representation of complex systems and 

processes with a concept map and at the same time visually simplify processes with flowchart 

diagrams. Type your idea as you think and visualize your mind in a second. It provides 

simplicity and easiness to your visual thinking process.  

iMindQ® makes the most of the core mind mapping functionalities with a single click 

navigation and very intuitive user interface. It offers a selection of features that provides you 

full advantage of the logical way of thinking. Words are not as powerful on their own as when 

you take the time to draw them into images. 

There are no more limitations in the map space, you are the designer and manager of what 

you will do with it and how you will represent things.  
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What’s in iMindQ® 9.0 

iMindQ® 9.0  introduces a new GUI.  The redesign of the GUI aims to streamline the mind 

mapping experience of the users.    

New Feature: 

 GUI redesign     
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Application Menu 

Overview 

iMindQ®’s graphic user interface is a combination of Microsoft Office ribbon interface and 

Menus, which includes ribbon strips with actions and menus with same actions that are 

implemented in the ribbons. 

iMindQ® contains a cluster of ribbon bars and inside the ribbon bars are placed all application’s 
functions. Detailed explanations of every ribbon and its features is given in ”Ribbons” heading in 
this manual. 

Application menus are locate at the top of the application, containing lists of same functions that 

are contained in the ribbon. Detailed overview of the menus as well as implemented shortcuts 

are given in the “Menus” and “Shortcuts” headings appropriately in this manual. 

iMindQ 

The iMindQ® menu is divided into several sections, and each sections contains a group of 

features that are responsible for application’s behavior in general. 

The look of the File menu with all available actions is presented on the figure below. 

 

The following features are available in the iMindQ® menu: 

Feature Description 

About iMindQ Opens up the About dialog for the product 

Preferences Opens up a dialog with configuration options for the application 

Services Present all services that are used by iMindQ® 

Hide iMindQ Sends iMindQ® out of user’s sight. It can be unhide using the “Show all” feature 

Hide Others Sends all opened applications out of user’s sight except the iMindQ® 

Show All Unhide al hidden applications and back them to user’s sight 
Quit iMindQ Closes the main windows and exits the program 

 iMindQ User Interface 
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File 

The File menu is divided into several section, containing actions with same starting point but 

different goals. Using the features form the File menu you can start new map or edit already 

created maps. Saving option is available through several features allowing you to save the map 

in different file formats. Before printing opened mind map, you can make the necessary 

adjustments for the printout. 

The look of the File menu with all available actions is presented on the figure below. 

 

Figure 1. File Menu in iMindQ® 

The following features are available in the File menu: 

Feature Description 

New This sub-menu contains a list of options that allow you to create a new map. 

New from Template Opens the library with all the available Templates in iMIndQ®.  

Open Shows the Open File dialog where you can browse for and select a map (.dmm file) 

to open in iMindQ®. Beside the native iMindQ® file format (.dmm file) user can 

save the map in one of the following formats: FreeMind map (.mm file format) and 

MindJet map (.mmap file format) and XMind map (.xmmap file format) 

Open Recent Opens a list of recently opened files, from which you can choose a file to open.  

Save This sub-menu contains a list of options to save the currently active map. Beside 

the native IMindQ® file format (.dmm file) user can save the map in one of the 

following formats: FreeMind map (.mm file format) and MindJet map (.mmap file 

format) and XMind map (.xmmap file format) 

Save As Save the document in the native file format. Beside the native IMindQ® file format 

(.dmm file) user can save the map in one of the following formats: FreeMind map 

(.mm file format) and MindJet map (.mmap file format) and XMind map (.xmmap 

file format). 

Save All Save all the currently opened maps.  

Save As Template Save the map as template with .dmmt file format.  

Save Protected Save the map as a password-protected file.  
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Print This sub-menu contains all the options you need to print the map - Print, Print 

Preview and Page Setup. Print shows the Print dialog where you can choose a 

printer to print the currently active map. 

Preview shows the Print Preview window for the currently active map. Page Setup 

opens the Page Setup dialog for the currently active map. 

Page Setup Opens the Page Setup dialog where you can set the general page settings, set the 

margins, as well as make custom Header and Footer for the Printed pages.  

Import This sub-menu contains a list of applications from which IMindQ® can import files.  

Export This sub-menu contains a list of formats and applications to which IMindQ® can 

export the information from currently active map 

Edit 

The Edit menu is divided into four sections, containing functions for reversing/repeating some 

actions, coping and pasting elements as well as finding/replacing topic’s parameters. 

The look of the Edit menu with all available actions is presented on the figure below. 

 

The following features are available in the Edit menu: 

Feature Description 

Undo Undo the last action 

Redo Redo the previously undone action 

Cut Makes replica of the cell’s data in the cell(s) temporary storage area and delete the 
contents afterwards 

Copy Makes replica of the cell’s data in the cell(s) temporary storage area 

Paste Replaces the contents of the cell(s) with the data that is stored in the temporary 

storage area 

Delete Deletes map’s elements (topics, subtopics) or topic’s elements (attached 
documents, icons, images) 

Find Provides an opportunity to search through the topics in the currently active map 

by using different criteria 

Replace Replaces one topic’s term with new one through entire map 

Advanced Search Males search through map’s elements according predefined search options. 

Insert 

The Insert menu is divided into several section, containing features for inserting the main map’s 
elements (topics, callouts, relationships and boundaries) as well as functions for adding topic 



 

 

 

 

 

11 iMindQ User Manual for Mac 

elements, such as notes, hyperlinks, images or attachments. In addition, with the features 

implemented in this menu you can add task properties to the every map’s topic or add custom 
properties. 

The look of the Insert menu with all available actions is presented on the figure below. 

 

The following features are available in the Insert menu: 

Feature Description 

Topic Insert “sibling” topic (topic on same level) of the selected topic 

Subtopic Inserts “child” topic of the selected topic 

Parent topic Inserts topic between the “parent” and “child” topic 

Floating topic Inserts topic that has no relationships with the with the topics that are under the 

Central topic 

Callout Inserts descriptive topic in the map 

Relationship Inserts a link between two topics in the map 

Boundary Inserts visual group of selected topics in the map 

Icons Inserts icon from the iMindQ®’s library in the selected topic 

Images Inserts image from the iMindQ®’s library or from specific file in the selected topic 

Attachments Adds external file to the selected topic 

Hyperlink Insert hyperlink to web page, map’s topic, map on web, external documents for the 
selected topic 

Notes Add note to the selected task 

Task Info Opens the Task info tab on the right side of the working area for inserting project 

management properties to the topic 

Date/Time Insert date and time in the map’s topic 

Properties Inserts the following types of custom properties in the topic: text, boolean, number, 

date, time and date and time 

Spreadsheet Inserts spreadsheet in the topic 
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Format 

The File menu is divided into four sections, containing features for editing topic’s text (font type, 
font size, alignments and etc.), location of the images and icons as well as the overview of the 

map in term of map’s structure and map’s style and background. 

The look of the Format menu with all available actions is presented on the figure below. 

 

The following features are available in the Format menu: 

Feature Description 

Font Opens sub-menu for editing the select text, such as changing font type and size, 

make it italic, bold or underline 

Text Opens sub-menu for setting the position of selected text 

Image Placement Selects the location where the appropriate image will be placed in the map’s topic 

Icon Placement Selects the location where the appropriate icon will be placed in the map’s topic 

Numbering Adds numbers to the topics and subtopics according predefined numbering 

scheme 

Topic Structure Arrange the map’s topics around the central topics using one from the available 
predefined map’s structure 

Topic Shape Change default topic’s shape using the shapes from the iMindQ®’s library or use 
your own shape or edit topic’s fill color, border color or transparency. 

Relationship Shape Change the default shape of the relationship 

Tie Types Define the tie types between the map’s topics. 
Relationship Shape Format the shape ( color, pattern, style )of the existing relationships between the 

topics in the map. 

Boundary Shape Format the shape ( style line color, line pattern, line weight, fill color and 

transparency ) of the existing boundaries in the map 

Map Style Apply different visual styles from the iMindQ® library into the map 

Background Insert one of the available patterns from the iMindQ®’s library into the map and 
change map’s background color 

Format Topic Changes the topic’s shape, fill parameters, line parameters, image shape and 
alignment 
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View 

The features implemented in the View menu will allow users to expand or collapse maps’ 
branches, to filter the map according specific criteria and to use different zooming functionalities 

in order to emphasize specific topic or branch. 

The look of the View menu with all available actions is presented on the figure below. 

 

The following features are available in the View menu: 

Feature Description 

Details Expand/Collapse the subtopics in the branch according the selected outline level 

Collapse All Collapse all subtopics for which parent is the selected topic. 

Select All Expand all subtopics for which parent is the selected topic. 

Select Branch Automatically selects all subtopics for which parent is the selected topic. 

Balance Map Automatically distributes the topics around the central topic for visual balance. 

Show Selected Topic Visually present the topic and its children topics that are previously hidden. 

Hide Selected Topic Visually hide the topic and its children topics from the map. 

Advanced Filtering Apply filter in the map to view different details in the map. 

Remove Filter Remove the applied filter from the map. 

Focus on Topic Automatically places the selected topic in the center of the screen. 

Center Map Automatically places the central topic (and entire map appropriately) in the center 

of the screen. 

Fit Map Zoom the map to the level that occupies the entire working area on the screen. 

Zoom In Enlarge the view of the map. 

Zoom Out Reduce the view of the map. 
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Window 

The Window menu contains features for manipulating application’s tabs and features for 
inserting topic elements in the map. In addition, this menu contains several views, allowing user 

to switch from task management view (Gantt Chart) into Outline (mind mapping) view. 

The look of the Window menu with all available actions is presented on the figure below. 

 

The following features are available in the Window menu: 

Feature Description 

Minimize Minimize the application to doc 

Zoom Zooms the content of the map 

Close tab Closes currently active map 

Close All but Active Closes all opened tabs except the tab that thee user is working 

Close All Tabs Closes all opened tabs in the application 

Show Next tab Opens the next tab to the currently opened one 

Show Previous tab Returns to the predecessor tab of the currently opened tab 

Gantt Chart Presents the topics that are transformed into task in Gantt Chart view 

Outline Opens new tab (Outline view) with all topics and subtopics arranged by their 

outline level code 

Presentation Panels Open the Scenes and Animation Panels.  

Map Parts Saves part of map containing the selected topic and its subtopics 

Task Information Opens the Task info tab on the right side of the working area for inserting project 

management properties to the topic 

Map Style Apply different visual styles from the iMindQ® library into the map 

Library Opens the Library docking window for inserting icons, images, shapes and 

patterns 

Notes Add note to the selected task 
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Help 

The Help menu contains features for starting application’s help and search through map’s terms. 

The look of the Help menu with all available actions is presented on the figure below. 

 

The following features are available in the Help menu: 

Feature Description 

Search Search through items inside the application 

What’s New in iMindQ Opens up the “What’s New” page of the context help which lets you quickly access 
information about the new features implemented in iMindQ® 

iMindQ help Opens up the Contents menu of the context help, which lets you to navigate the 

entire help through the available categories organized in hierarchy 

 

Backstage View (File Menu), Quick Access Toolbar and Quick Topic Menu 

Introduction 

iMindQ®’s graphic user interface is based on Microsoft Office 2013 ribbon interface, which 

includes ribbons instead of standard menus, quick access toolbar as replacement for the toolbars 

and application menu as an alternative for the File menu. Also three new dynamic ribbons are 

added, that are selection dependent. 

IMindQ® contains a cluster of ribbon bars and inside the ribbon bars are placed all application’s 
functions. Detailed explanations of every ribbon and its features is given in Walkthrough 

IMindQ® ribbons heading in this manual.  

The quick access toolbar can be treated as repository place, where the most used functions, such 

as New, Undo & Redo, Save are placed. For more information regarding the quick access toolbar 

go to the “Info” part of this document. 

Backstage View 

The Backstage view is the first ribbon in iMindQ® viewing from left to right. It consists of 

functions and tabs arranged in vertical order. Named as “File”, it is a place where you can manage 
your maps and diagrams. Through the Backstage view you can open/close different types of 

maps, take a closer look of what has been created using the print preview or make printout of 
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the Map, Gantt Chart or Map Outline. Export and Import features are placed inside the Backstage 

view along the features for collaboration with Microsoft Outlook and other. 

The look of the Backstage view is presented in the figure below. 

 

Figure 2. Backstage View (File Menu) in iMindQ® 

The following features are available in the Backstage View (File Menu): 

It contains 6 tabs in the following order: 

 Info 

 New 

 Open 

 Save As 

 Print 

 Share 

 Import/Export 

 

As well 3 functions for managing project and application’s preferences: 
 

 Save 

 Close 

 Options 
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Info Tab 

The “Info” tab, presented on the figure below, displays information of the project plan. It is 

divided into two sections: the left section consist of features for presenting detailed project 

information while the right sections contains project’s dates such as Star and Finish date, Status 
and Current date as well as project calendar and its priority. 

The functions that are available in the Info tab are: 

 Feature Description 

 

Protect Map Opens up the  Protect map dialog where you can insert map 

password for protecting map’s information 

Sometimes, during your brainstorm session or map creation process, you want to keep the 

information save, available for viewing only for few people. In this case you have to protect your 

map with password, and share it with selected people. “Protect Map” functionality inside 
iMindQ® will help you to secure the map’s information. 

This action can be done in several steps: 

1. Open the mind map 

2. From the File ribbon, click on the Info tab 

3. Click on the Protect Map button 

4. In the newly opened dialog, insert the password for protecting the map’s information 

Note: The password is case sensitive information. Keep it on save place, because if you lose it, it 

cannot be recovered. 

 

New Tab 

Starting new, blank map or map based on template is performed using the New tab from the File 

menu. It contains two main sections: New and Template. 

The New section contains the five different map types that are currently available in iMindQ®: 

1. Mind Map 

2. Organic Mind Map expression  

3. White Board 

4. WBS Chart 

5. Organizational Chart 

Selecting one of them will load the working space with the appropriate working area and 

elements. 
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The Template section contains map templates that can be used as base for creating mind maps, 

divided into several categories (Business, Educational and Personal). For a quick start, you can 

use the search option through the templates, finding the most appropriate template for your 

map in very short period of time. 

 

Open Tab 

The Open section is the most visited tab in the File menu. It allows users to open mind map from 

their PC and continue to work on them, download maps from Web iMindQ® and Microsoft 

SharePoint and edit them. 

The “Open” tab contains sub-tabs: 

 Recent Maps 

 Computer 

 SharePoint Online 

iMindQ® keeps track of the mind maps that you have recently opened and store this information 

inside the “Recent maps” sub-menu. It contains a list from recently opened maps, allowing you 

to quickly access the desired file and start working on it. 

The “Computer” sub-menu contains a lists of folders that you have recently visited and opened 

mind maps from them. I case you need to open folder that is not on the list, by using the “Browse” 
button you can navigate to the preferred folder where your map is saved and open it. 

The “SharePoint 365” feature, allows you to import mind maps uploaded on SharePoint Online 

(SharePoint 365), work on the map and then uploaded it. In order to synchronize the information 

between the desktop and the SharePoint, your IT administrator must grant you permissions for 

accessing the SharePoint Online server. 

Feature Description 

.dmmx Default file format in which iMindQ saves the maps. 

.dmmt Default file format for iMindQ Templates.  

.dmms Default file format for iMindQ Styles.  

.dmmw Default file format for iMindQ Workspace, where more than one map can be saved in one file.  

.mmap Default file format for MindJet MindManager.  

.mm Default file format of FreeMind.  

.xmind Default file format of XMind.  

 

Print Tab 

To manage mind maps effectively, you may need to communicate map information to a variety 

of people. With iMindQ®, you can print maps and charts that present the exact information you 

want. 
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The process of printing the information you need can be as simple as clicking a button or as 

refined as customizing and previewing the existing views. No matter how simple or refined the 

process, printing a map or chart consists of essentially the same steps: 

 Select the map or chart that best presents the information you want – If a predefined map 

or chart does not meet your exact needs, you can apply different styles. 

 Make display changes to the map or chart – For example, you may want to scale 

information to fit on a single page. 

 Preview a map or chart before it is printed – Previewing a view or report can help you 

verify content and display changes you made so you can adjust them again if necessary. 

 Print the map or chart – To make printing as efficient as possible you can specify the 

options you want. For example, you can print a range of pages (defined by page numbers 

or dates), suppress blank pages, and print multiple copies. 

You can make changes to the way a printed view or report looks by specifying page setup options 

such as page orientation, scale, or paper size. 

Once you open the Page Setup dialog, you can follow the steps below to specify the page and 

other printing options for a view or a report. Note that some of the options in the Page Setup 

dialog available for views may not be available for the reports.  

 

Some options may differ between different views as well: 

1. Click the Page tab in the Page Setup dialog. 

2. To change page orientation, under Orientation, click Portrait (vertical) 

or Landscape (horizontal). 

3. To scale pages, under Scaling, click Adjust to, and then type the percentage at which you 

want information to appear on your printed pages in the % normal size box. 

4. To adjust page fit (some views only), under Scaling, click Fit to, and then specify the number 

of pages you want in the pages wide by and tall boxes. 

5. To change the paper size, click the paper size you want in the Paper Size box. 
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6. Click the Margins tab. 

 

1. In the Top, Bottom, Left, and Right boxes, type or select the new margin settings 

2. To place the map in the center of the page, select the Horizontally and Vertically check 

boxes in the Center on page frame. 

3. Click on the Header tab. 

 

1. To select the font of the Custom header, click on the Font button 

2. To insert an image in the Custom header, click on the Image button 

3. To select the alignment of the header’s text or image, click on the Right, 

Center or Left button 

4. Click on the Footer tab. 
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1. To select the font of the Custom header, click on the Font button 

2. To insert an image in the Custom footer, click on the Image button 

3. To select the alignment of the footer’s text or image, click on the Right, 

Center or Left button. 

4. Before printing a map or chart, in addition to the page setup options, you can specify 

print options such as the printer and its properties, the print range for pages, the number 

of copies, and the date range. 

5. In the File tab, click on the Print sub-tab. 

6. From the Printer drop-down menu select the appropriate printer. 

7. In the Settings portion of the Print sub-tab select the page orientation, paper size and 

the map’s part (mind map, outline or notes). 
8. To print the map or chart click on the Print button. 

 

Share Tab 

Sharing the ideas, brainstorming records among team members or colleagues is useful because 

you want to spread the word to get your idea off the ground and to receive valuable feedbacks. 

The “Share” functionality in iMindQ® gives an opportunity to the users to send messages to their 

colleagues with entire mind map as attachment. Before sending the e-mail, sender must save the 

mind map. 

The process for sharing mind map among colleagues is very easy and it is performed in several 

steps: 

1. Open/Save the mind map 

2. From the “File” menu select the “Share” tab 
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3. Click on the “Send As Attachment” button 

 

Import/Export 

“Import/Export” tab is divided in four major sub-tabs that allows converting information from 

various applications from MS Office into map in iMindQ®, exporting map’s information in various 

file formats, convert it into pdf file or save the map’s content into different file type. The 
implemented features in the “Import/Export” tab are described in the sections below. 
Import 

The following features are implemented in the “Import” tab: 
 Feature Description 

 

Microsoft Project Creates iMindQ map based on existing Microsoft Project file. 

 

Microsoft Excel Opens the Excel Importer panel for importing Microsoft® Excel file 

(.xlsx file format) from which data will be presented in an iMindQ® 

map. 

 

OPML Opens the OPML (Outline Processor Markup Language) file, from 

which a mind map is created. Exports the map as an outline tree of 

the map content.   

 

Import Template Import existing templates (.dmmt file) in iMindQ. 

 

Calendar  Imports Calendar events from different calendars to a topic in 

iMindQ.   

 

Reminders Imports reminders from the Reminders App from different lists, to a 

topic in iMindQ.  

 

To import Microsoft Project file, you have to perform the following steps: 

1. Open/Save the mind map. 

2. From the “File” menu select the “Import/Export” tab. 

3. Click on the “Import from MS Project” button. 

4. Browse to the location where the file is placed. 

5. Load the file. 
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Export 

“Export” tab contains the following options: 
 Feature Description 

 

Image Opens up the  Protect map dialog where you can insert map 

password for protecting map’s information 

 Rich Text Format Exports the current map information as a text outline for Microsoft 

Word (.rtf file format) 

 

HTML Map  Export the map as an interactive HTML map that can be 

zoomed, expanded, collapsed and shared.  

 

HTML Web Page Exports the IMindQ® map as web page in .html format.  

 

Microsoft Excel (CSV) Exports the information in a textual, comma-delimited format. The 

exported file can be opened in Microsoft® Excel or any text 

editor. This format exports the task or resource information in raw 

table format, with no formatting or outline information. 

 

Microsoft Project Exports the map information as Microsoft Project file. 

 

ODT Exports the map information as Open Document Text (ODT) file. 

Common for exporting into all types is that you have to save the mind map, set the exporting 

settings (for exporting to image, Microsoft Project and Microsoft Outlook) and then select 

the location and the name of the output file. 

 

Save Map as File 

iMindQ® uses the .dmmx file format to save the mind maps. In case, you want to share 

information with people that have older version of iMindQ® (DropMind) or another mind map 

application, you can work in compatibility mode or to save the information in the third-party 

applications file formats. 

The following file formats are available: 
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Feature Description 

.dmmx Default file format in which iMindQ saves the mind maps. 

.dmm Old file format in which iMindQ saves the mind maps. 

.dmms iMindQ file format for saving maps styles. The styles in the file can be edited 

and then imported and applied in the map. 

.dmmt iMindQ template file format. This file can be used as a base when starting 

preparing mind maps. 

.dmmw iMindQ workspace file format. This file can be used as a start point when 

working with several maps at time. 

.mm FreeMind file format in which iMindQ is capable to store the information 

from the mind maps. 

.mmap MindManager default file format in which iMindQ is capable to store the 

information from the mind maps. 

.xmmap MindManager xml map file format in which iMindQ is capable to store the 

information from the mind maps. 

For exporting the map in one of the available file formats, you have to save the latest changes in 

the mind map, and then choose the appropriate file format: 

1. Open/Save the mind map. 

2. From the “File” menu select the “Import/Export” tab. 

3. Click on the “Save Map as file” button. 

4. Browse the location and name the output file. 

5. Click on the “OK” button. 

Quick Topic Menu 

The Q-menu is a unique iMindQ quick access menu which is available only in the map space. 

You can find the Q-menu in the upper-right or upper-left corner of a topic, once you hover 

over the topic with your mouse, as shown on the figure below. This menu is intended to 

provide the user ability to add topic, add relationship or format the topic on the fly while 

building its map.  

 

Figure 3. Quick Topic Menu 
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The Quick Topic Menu is divided in to three main parts that provide the following functionality: 

 Feature Description 

 

Add Subtopic Insert subtopic topic by single click on the plus icon or click 

once on the plus icon, hold and drop the topic in the empty 

map space.   

 

Add Relationship Create relationship where the start topic is the selected one. 

Drag and drop the end point of the relationship to another 

topic from map or drop it in the empty map space. This will 

create a new Floating topic. 

 

Format Topic Open the format topic dialog. 

 

Ribbons 

Introduction  

iMindQ® is software designed to work with Ribbon user interface, where application’s 
functionalities are placed in tabs in a tab bar. By its definition, Ribbon is a single tab bar that 

contains graphical elements as representation for different functionalities. Several application’s 
controls with similar functionalities can form a Group inside the Ribbon. 

The iMindQ® Graphic User Interface consists of Application menu, where all features from the 

File menu from the Standard GUI are placed and Ribbons containing the other viewing features.  

 

Figure 4. Ribbon elements 

Ribbon overview 

IMindQ® contains six standard ribbons: 

 Home 

 Insert 

 Format 

 View 

 Present 

 Exchange 

 Plan  
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Detailed description of the iMindQ® ribbons is given in the “Walkthrough iMindQ® ribbons” 
section. 

iMindQ® contains additional three dynamic ribbons, selection dependent: 

 Topic Format  

 Relationship Format 

 Boundary Format 

 

Working space 

After installing and starting iMindQ® you will see user interface as it is presented on the figure 

below. 

 

Figure 5. iMindQ® Working space 

The main elements of the working space in iMindQ® user interface are: 

 Ribbons – containing all commands available in iMindQ® grouped by the type of action. 

Detail explanation of the commands is given later in this chapter. 

 Application menu – containing features for starting new maps, opening already created 

maps, printing and synchronizing with Web iMindQ® 

 Working area – space where the map is created, edited and viewed.  

 Backstage View (File Menu)  
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Walkthrough IMindQ® ribbons 

Home ribbon 

Home ribbon in iMindQ® contains the most used commands for creating and editing a map, 

such as inserting new topic in the map, formatting the topic’s text, insert notes to the topic, 

change the background of the map, etc. All features are categorized according to their similarity 

and functionality and organized in six groups, as illustrated in the figure below 

 

Figure 6. Home ribbon in iMindQ® 

Clipboard group 

The Clipboard group in the Home ribbon is presented on the figure below: 

 

Figure 7. Clipboard group in Home ribbon 

The Clipboard group contains features for copying and pasting different elements from the map. 

The following actions are available: 

 Feature Description 

 
Paste Replaces the contents of the cell(s) with the data that is stored in 

the temporary storage area 

 
Cut Makes replica of the cell’s data in the cell(s) temporary storage 

area and delete the contents afterwards 

 
Copy Makes replica of the cell’s data in the cell(s) temporary storage 

area.    

 

Format Painter Format topic’s fill color, border color, shape and text color 

 

Text and Color group 

Text and Color group with the implemented functionalities is presented on the figure below: 
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Figure 8. Text and Color group in Home ribbon 

The topic’s text in the map can be changed using the features from the Text and Color group 

group. The following actions are available: 

 Feature Description 

 Font Type Change the font type of the selected text 

 Font Size Change the font size of the selected text 

 Increase Font Size Increase the font size of the selected text with fix step 

 Decrease Font Size Decrease the font size of the selected text with fix step 

 Bold Make text bold 

 Italic Make text italic 

 Underline Underline the selected text 

 Strikethrough Draw a line through the middle of the selected text 

 Change Font Color Change the color of the selected text 

 
Line Color Change the color of the topic boundary and the connector line 

 
Fill Color Change the color of the topic’s inside.  

 Alignment Change the position of the selected text 

 
Clear Formatting Delete all custom settings and return the default settings 

 

Map Elements group 

Map Elements group with the implemented functionalities is presented on the figure below: 

 

Figure 9. Map Elements group in Home ribbon 

Different types of topics such as subtopic, floating topic or callout can be added in the map using 

the features from the Map Elements group. The following actions are available: 

 Feature Description 

 
Topic Insert “sibling” topic (topic on same level) of the selected topic 
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Subtopic Inserts “child” topic of the selected topic 

 
Callout Inserts descriptive topic in the map 

 
Relationship Inserts a link between two topics in the map 

 

Boundary Inserts visual group of selected topics in the map 

 

Topic Elements group 

Topic Elements group with the implemented functionalities is presented on the figure below: 

 

Figure 10. Topic Elements group in Home ribbon 

By using one of the features located in the Topic Elements group, you can add new notes or edit 

an existing one, insert hyperlinks to different objects, attach files to the topics etc. The following 

features are available: 

 Feature Description 

 Notes Add note to the selected task. 

 

Hyperlink Insert hyperlink to web page, map’s topic, map on web, external 

documents for the selected topic. 

 Attach Add external file to the selected topic. 

 
Icon Insert icon from the IMindQ®’s library in the selected topic. 

 

Image Insert image from the IMindQ®’s library or from specific file in the 

selected topic. 

 

Editing group 

Editing group with the implemented functionalities is presented on the figure below: 
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Figure 11. Editing group in Home ribbon 

Spelling the map’s text and removing the objects that are inserted in the map’s topics are done 
using the features from the Editing group. The following actions are available: 

 Feature Description 

 

Style Apply different visual styles from the IMindQ® library into the 

map. Create your own topic’s style library and manage it or 
insert one of the available patterns from the IMindQ®’s library 
into the map and change map’s background color. 

 

Spelling Check the spelling of the selected text from the map 

 

Clear Clear the changes that are done in the map. 

 

Insert ribbon 

Insert ribbon in iMindQ® contains features for adding different types of topics in the map, edit 

the topics in term of adding elements such as notes, images, icons, custom properties and other 

elements, as well as create new map as part of the current one. All features are categorized 

according their similarity and functionality and organized in three groups. 

 

Figure 12. Insert ribbon in iMindQ® 

The available subset of functions placed in the Home ribbon classified in groups is presented 

below: 

 

Map Elements group 

Map Elements group is presented on the figure below: 
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Figure 13. Map Elements group in Insert ribbon 

Different types of topics such as subtopic, floating topic or callout can be added in a map by 

using the features from the Map elements group. The following actions are available: 

 Feature Description 

 
Topic Insert “sibling” topic (topic on same level) of the selected topic. 

 

Subtopic Inserts “child” topic to the selected topic. 

 

Parent Topic Inserts topic between the “parent” and “child” topic. 

 

Floating Topic Inserts topic that has no relationships with the with the topics 

that are under the Central topic 

 

Callout Inserts descriptive topic in the map 

 

Relationship Inserts a link between two topics in the map 

 

Boundary Inserts visual group of selected topics in the map 

 

Topic Elements group 

The Topic Elements group is presented on the figure below: 

 

Figure 14. Topic Elements group in Insert ribbon 

In the Topic Elements group, the following features are available: 

 Feature Description 
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Notes Add note to the selected task 

 

Hyperlink Insert hyperlink to web page, map’s topic, map on web, external 

documents for the selected topic 

 

Attach Add external file to the selected topic 

 

Icon Insert icon from the IMindQ®’s library in the selected topic 

 

Image Insert image from the IMindQ®’s library or from specific file in the 
selected topic 

 

Task Info Opens the Task info tab on the right side of the working area for 

inserting project management properties to the topic 

 

Date & Time Insert date and time in the map’s topic 

 

Alert Insert alert to the map’s topic 

 

Spreadsheet Inserts spreadsheet in the topic 

 

Custom Properties Inserts the following types of custom properties in the topic: text, 

boolean, number, date, time and date and time 

 

Map group 

The look of the Map group in the Insert ribbon is presented on the figure below: 

 

Figure 15. Map group in Insert ribbon 

Saving map parts and creating new maps from different branches of the master map is performed 

with features located in the Map group. The following features are available in this group: 

 Feature Description 
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Map Parts Saves part of map containing the selected topic and its subtopics 

 

Build As Map Create a new map where the selected topic from the master map 

is central topic in the new map 

Design ribbon 

The Format ribbon in iMindQ® contains features for editing map’s topics such as topic’s font, 
size, shape, color and position; map’s structure, layout, background color and pattern, spacing 

and alignment of topics, ordering of topics etc. All features are categorized according their 

similarity and functionality and organized in four groups. 

 

Figure 16. Format ribbon in iMindQ®  

 

Topic Structure  

The Topic Structure functionalities are presented in the figure bellow: 

 

Figure 17. Topic Structure in Design ribbon 

The following features are available in this group: 

 Feature Description 

 

Balance Topic  Balance Map feature allows you to align the topic in the map. 

 

Balance Subtree  Balance Subtree feature allows you to align the topics of the 

selected subtree 

 

Shrink Subtree  Shrink Subtree feature allows you to shrink the topics of the 

selected subtree  
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Formatting group 

The look of the Formatting group in the Format ribbon is presented on the figure below: 

 

Figure 18. Formatting group in Format ribbon 

The following features are available in this group: 

 Feature Description 

 
Topic Shape 

 

Apply different visual styles from the iMindQ® library into the 

map, as well as manage styles, both new and existing ones. Add 

gradient color to an entire branch. Create mind map with 

spectrally colored ties.  

 

Relationship Shape 

 

Insert one of the available patterns from the iMindQ®’s library 
into the map and change map’s background color 

 

Boundary Shape 

 

Format the shape ( style line color, line pattern, line weight, fill 

color and transparency ) of the existing boundaries in the map 

 

Tie Types 

 

Define the tie types between the map’s topics 

 

Line 

 

Edit the line style and weight for the selected relationship or 

boundary 

 
Icon Placement 

 

Select the location where the appropriate icon will be placed in the 

map’s topic 

 
Image Placement 

 

Select the location where the appropriate image will be placed in 

the map’s topic 

 

Numbering Add numbers to the topics and subtopics according predefined 

numbering scheme 
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Styles group 

Styles group with the implemented functionalities is presented on the figure below: 

 

Figure 19. Styles group in Format ribbon 

Changing map’s style (topic’s shape, color, background color and pattern) can be done using the 
features from the Styles group. The following features are available in this group: 

 Feature Description 

 

Style Create your own style library and manage it 

 

Background  Insert one of the available patterns from the iMindQ®’s library into 
the map and change map’s background color 

 

Adjust topic group 

Resize topic group with the implemented functionalities is presented on the figure below: 

 

Figure 20. Adjust group in Format ribbon  

Changing topic size (topic's width, topic's height or both) can be done using the features from 

the Resize topics group. The following features are available in this group: 

 Feature Description 
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Horizontal Spacing  Distributes the selected topics horizontally  dividing equal spacing 

between the selected topics. 

 

Vertical Spacing  Distributes the selected topics  vertically dividing equal spacing 

between the selected topics. 

View ribbon 

The View ribbon in iMindQ® contains features for working with the map, such as view different 

branches of the map, expand or collapse the topics and subtopics, balance the map, etc. All 

features are categorized according their similarity and functionality and organized in five groups. 

 

Figure 21. View ribbon in iMindQ® 

The available subset of functions placed in the View ribbon classified in groups is presented 

below: 

 

Views group 

The look of the View group in the View ribbon is presented on the figure below: 

 

Figure 22. View group in View ribbon 

To present the map into outline view or to get the maximum of the working area for presenting 

the map you can use the features implemented in the View group. The following features are 

available in this group: 

 Feature Description 

 

Gantt Chart 

 

Presents the topics that are transformed into task in Gantt Chart 

view 
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Outline 

 

Distributes the selected topics  vertically dividing equal spacing 

between the selected topics. 

 

Full Screen 

 

Maximize the working area on the entire screen 

Detail group 

The look of the Detail group in the View ribbon is presented on the figure below: 

 

Figure 23. Detail group in View ribbon 

For hiding or presenting different levels of the map you can use the features that are 

implemented in the Detail group. The following features are available in this group: 

 Feature Description 

 

Details Expand/Collapse the subtopics in the branch according the 

selected outline level 

 

Collapse All Collapse all subtopics for which parent is the selected topic 

 

Expand All Expand all subtopics for which parent is the selected topic 

 

Select Branch Automatically selects all subtopics for which parent is the 

selected topic 

 

Map group 

The look of the Map group in the View ribbon is presented on the figure below: 
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Figure 24. Map group in View ribbon 

If you want to automatically place the map/topic in the center of your screen or to balance the 

topics in the map, use the features from the Map group. The following features are available in 

this group: 

 Feature Description 

 

Focus On Topic Automatically places the selected topic in the center of the 

screen 

 

Center Map Automatically places the central topic (and entire map 

appropriately) in the center of the screen 

 

Balance Automatically distributes the topics around the central topic for 

visual balance  

 

Filter group 

The look of the Filter group in the View ribbon is presented on the figure below: 

 

Figure 25. Filter group in View ribbon 

To view different details from the map use the features from the Filter group. The following 

features are available in this group:  

 Feature Description 

 

Filter Apply filter in the map to view different details in the map. 

 

Remove Filter Remove the applied filter from the map. 
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Show Branch Alone Presents the selected branch alone, without the central topic and 

the other branches. 

 

Show All Branches Present the map with all branches after “Show Branch Alone” 
feature was selected. 

 

Zoom group 

The look of the Zoom group in the View ribbon is presented on the figure below: 

 

Figure 26. Zoom group in View ribbon 

The following features are available in this group: 

 Feature Description 

 

Fit Map Zoom the map to the level that occupies the entire working area 

on the screen. 

 

Zoom In Enlarge the view of the map. 

 

Zoom Out Reduce the view of the map. 

 

Present ribbon 

In the Present ribbon in iMindQ, the user can make an automatic or custom presentation for 

mind maps, WBS, organic maps and organizational charts. The user can also make presentation 

for Flowchart diagrams and other types of maps, by using Template scenes with predefined 

animations.  
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Figure 27. Present ribbon in iMindQ® 

The available subset of functions placed in the Present ribbon classified in groups is presented 

below: 

Scene group 

The look of the Scene group in the Present ribbon is presented on the figure below: 

 

Figure 28. Scene group in Present ribbon 

The following features are available in this group: 

 Feature Description 

 

Generate Scenes Automatically generate scenes for a mind map, organic Mind 

Map, WBS and organizational chart with predefined animations.  

 

Add Scene Adds scene in the Scenes Panel for the selected topic(s). The 

Add Scene menu contains Template Scenes that contain 

dynamic predefined animations.  

 

Add Animation  Adds animation to the selected topic(s) as a selected single 

item or as parent topic including the child topics.  

 

Change Transition Changes the Transition to the selected Scene(s) or acts as a 

default Transition for a new created Scene if there is no 

selection in the Scenes Panel. Two transition effects: Pan and 

Jump To.  

 

Preview Scene Preview of the selected scene.  
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Present group 

The look of the Present group in the Present ribbon is presented on the figure below: 

 

Figure 29. Scene group in Present ribbon 

The following features are available in this group: 

 Feature Description 

 

From Beginning Automatically plays a presentation for a Mind Map, Organic Mind 

Map, WBS and Organizational Chart; if there are no scenes in the 

Scenes Panel. Otherwise plays the presentation from beginning.   

 

From Current  Plays the presentation in a Full Screen Presentation View from the 

currently selected Scene.   

 

Views 

The look of the Views group in the Present ribbon is presented with the figure below:  

 

Figure 30. Views group in Present ribbon 

The following features are available in this group: 

Exchange ribbon 

The Exchange ribbon in iMindQ® allows you to import data into a mind map, such as data from 

the MS Office suite: MS Excel and MS Project. iMindQ® allows you to export data to MS 

Project, and other type of formats, such as PDF, HTML, RTF etc.  
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Figure 31. Exchange ribbon in iMindQ® 

Collaborate group 

The look of the Collaborate group in the Exchange ribbon is presented on the figure below: 

 

Figure 32. Collaborate group in Exchange ribbon 

iMindQ® collaborates with the following Microsoft® Office suite applications, and each of them 

collaborates in a different manner with iMindQ® explained in more details in other parts of the 

User Manual.  

 Feature Description 

 

PDF Exports the IMindQ® map into Adobe portable document 

format (.pdf file format). 

 

Image  Exports the IMindQ® map as image (.jpg file format). 

 

HTML Web Page Exports the IMindQ® map as web page in .html format.  

 

CSV Exports the WBS (Work breakdown structure) task 

information in CSV (Comma Separated Value) file format.  

 

ODT Exports the content of the map as ODT (Open Document 

Text) file.   
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Export group 

The look of the Export group in the Exchange ribbon is presented on the figure below: 

 

Figure 33. Export group in Exchange ribbon 

You can export the iMindQ® map content into the following file formats: 

 Feature Description 

 

PDF Exports the IMindQ® map into Adobe portable 

document format (.pdf file format). 

 

Image  Exports the IMindQ® map as image (.jpg file format). 

 

HTML Web Page Exports the IMindQ® map as web page in .html format.  

 

CSV Exports the WBS (Work breakdown structure) task 

information in CSV (Comma Separated Value) file format.  

 

ODT Exports the content of the map as ODT (Open Document 

Text) file.   

 

Plan ribbon 

The Plan ribbon in iMindQ® allows you to easily access the Gantt Chart view, as well as add 

different elements of a plan in the map (summary task, task, subtask, milestone). In the same time 

allows you to outline task data from the map and get quick project info. The Plan ribbon is 

consisted of six groups.  
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Figure 34. Plan ribbon in iMindQ® 

 

View group 

You can see the View group in the figure below: 

 

Figure 35. View Group in the Plan ribbon 

The following features are implemented in the View group: 

 Feature Description 

 

Gantt Chart View Gives visual representation of the entire plan and plan’s tasks with 

appropriate info sorted in columns.  

 

Insert Group 

The elements in the Insert group from the Plan ribbon can be seen in the following figure: 

 

Figure 36. Insert Group in the Plan ribbon 

The following features are implemented in the Insert group: 

 Feature Description 

 

Project Branch Makes the selected branch a summary task  
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Task Adds new task on the same level as the selected one.  

 

Summary Inserts summary (parent) task to the selected task.  

 

Milestone Turns a selected item as event that receives should receive special 

attention and signals the completion of a key deliverable. 

 

Schedule group 

The elements of the Schedule group in the Plan ribbon are represented in the figure below. 

 

Figure 37. Schedule Group in the Plan ribbon 

The following features are implemented in the Schedule group: 

 Feature Description 

 

Indent Selected task becomes a subtask of the task above, which 

becomes summary task. 

 

Outdent Selected task is moved back to the level of the task above and it 

is no longer a subtask. 

 

Project Group 

The elements of the Project group in the Plan ribbon are represented in the figure below: 

 

Figure 38. Project Group in the Plan ribbon 

The following features are implemented in the Project group: 
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 Feature Description 

 

Project Info Opens up the Project Information dialog with general 

information for the project plan. 

 

Change Working Time Change the working time for the project plan; insert 

exception days and create custom working weeks according 

your needs. 

 

Color Gantt Chart  Colorizes the task bars in the Gantt Chart View, by inheriting 

the tasks fill color in the map space.  

 

Late Task  Marks all tasks that should be finished at the current date, but 

their % Complete is not 100%. 

 

Show Task Info Show/Hide Task Info in topics. Manage which Task Info will 

be visible in the map space.  

 

Task Group 

The look of the Task group can be seen in the following figure: 

 

Figure 39. Task Group in the Plan ribbon 

The following features are implemented in the Task group: 

 Feature Description 

 

Information Opens up the Task Information dialog for the selected task. 

 

Task Notes Opens the Topic Notes tab for selected task/topic. 

 

Data group 

The look of the Data group can be seen in the following figure: 
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Figure 40. Data Group in the Plan ribbon 

The following features are implemented in the Data group: 

 Feature Description 

 

Tables Opens tables in the Gantt Chart specifically for Entry, 

Summary, Tracking and Usage.  

  

Hide Subtasks Shows or hides subtasks in the map. 

 

Filter group 

The look of the Filter group in the View ribbon is presented on the figure below: 

 

Figure 41. Filter group in View ribbon 

To view different details from the map use the features from the Filter group. The following 

features are available in this group:  

 Feature Description 

 

Filter Apply filter in the map to view different details in the map. 

 

Remove Filter Remove the applied filter from the map. 

 

Show Branch Alone Presents the selected branch alone, without the central topic 

and the other branches. 

 

Show All Branches Present the map with all branches after “Show Branch Alone” 
feature was selected. 
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Format Topic contextual ribbon 

Format Topic contextual ribbon in iMindQ® contains features for creating and editing map's 

topics plans. All features are categorized according their similarity and functionality and 

organized in five groups. 

 

Figure 42. Format Topic Ribbon in iMindQ® 

 

Text and Color group 

The Text and Color group with the implemented functionalities is presented on the figure below: 

 

Figure 43. Text and Color group in Format ribbon 

The topic’s text in the map can be changed using the following features:  

 Feature Description 

 Font Type Change the font type of the selected text 

 Font Size Change the font size of the selected text 

 Increase Font Size Increase the font size of the selected text with fix step 

 Decrease Font Size Decrease the font size of the selected text with fix step 

 Bold Make text bold 

 Italic Make text italic 

 Underline Underline the selected text 

 Strikethrough Draw a line through the middle of the selected text 
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Change Font Color Change the color of the selected text 

 
Line Color Change the color of the topic boundary and the connector 

line 

 
Fill Color Change the color of the topic’s inside 

 Alignment Change the position of the selected text 

 
Clear Formatting Delete all custom settings and return the default settings 

 

Shapes group 

Shapes group with the implemented functionalities is presented on the figure below: 

  

Figure 44. Shapes group in Format Topic ribbon 

You can choose different shapes for map's topics from the gallery placed in the ribbon. In case 

the desired shape is not in the gallery, you can add custom shape to the topic using the "From 

Library" functionality. 

 

Line group 

The Line group is presented on the figure below: 

  

Figure 45. Line Group in Format Topic ribbon 

The following actions are available: 

 Feature Description 
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Tie Types Define the tie types between the map’s topics 

 Border Define the topic's width 

 Tie Define the tie's width 

Structure group 

Structure group with the implemented functionalities is presented on the figure below:  

Figure 46. Structure group in the Format Topic ribbon 

The following actions are available: 

 Feature Description 

 

Topic Structure Arrange the map’s topics around the central topics using one 
from the available predefined map’s structure 

 
Split Topic Split the text in the topic either as topic, as subtopic, as 

multiple topics or as multiple subtopics.  

 

Icon Placement Select the location where the appropriate icon will be placed 

in the map’s topic 

 

Image Placement Select the location where the appropriate image will be 

placed in the map’s topic 

 

Numbering Add numbers to the topics and subtopics according 

predefined numbering scheme 

 

Adjust group 

Adjust group with the implemented functionalities is presented on the figure below: 
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Figure 47. Adjust group in the Format Topic ribbon 

Changing topic size (topic's width, topic's height or both) can be done using the features from 

the Adjust topics group. The following features are available in this group: 

 Feature Description 

 

Horizontal Spacing 

 

Distributes the selected topics horizontally dividing equal spacing 

between the selected topics. 

 

Vertical Spacing  Distributes the selected topics vertically dividing equal spacing 

between the selected topics. 

 

Format Relationship contextual ribbon 

Format relationship ribbon in iMindQ® contains features for editing map's relationships. All 

features are categorized according their similarity and functionality and organized in three 

groups. 

 

Figure 48. Format Relationship Ribbon in iMindQ® 

Line group 

The Line group is presented on the figure below: 

  

Figure 49. Line group in the Format Relationship ribbon 
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The following actions are available: 

 Feature Description 

 

Color Define the relationship color 

 Width  Define the relationship's width 

 Pattern Define the relationship's pattern 

Format group 

The Format is presented on the figure below: 

  

Figure 50. Format group in the Format Relationship ribbon 

The following actions are available: 

 Feature Description 

 

Flip Replace the starting and finishing point of the relationship 

respectively 

 

Jump to Start Put the focus on the starting point of the relationship 

 
Jump to Finish Put the focus on the finishing point of the relationship 

 

Style group 

The Style group is presented on the figure below: 

  

Figure 51. Style group in the Format Relationship ribbon 

The following actions are available: 

 Feature Description 

 Gallery Select the relationship style from the gallery in the ribbon 

 Begin Style Define the beginning style of the relationship 

 End Style Define the ending style of the relationship 

 
Follow Line When selected the label of the relationship will follow the 

shape adjustments of the relationship.  
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Format Boundary ribbon 

Format boundary ribbon in iMindQ® contains features for editing map's boundaries. All features 

are categorized according their similarity and functionality and organized in three groups. 

 

Figure 52. Format Boundary Ribbon 

 

Line group 

The Line group is presented on the figure below: 

  

Figure 53. Line group in the Format Boundary ribbon 

The following actions are available: 

 Feature Description 

 

Color Define the boundary color 

 Width  Define the boundary’s width 

 Pattern Define the boundary’s pattern 

 

Fill group 

The Fill group is presented on the figure below: 

  

Figure 54. Fill group in the Format Boundary ribbon 
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The following actions are available: 

 Feature Description 

 

Color Define the boundary's fill color. 

 Transparency Define the transparency of the filled color. 

Style group 

The Style group is presented on the figure below: 

  

Figure 55. Style group in the Format Boundary ribbon 

You can choose different shapes for the topic’s boundary from the gallery placed in the ribbon. 
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What is a map? 

What is map? Map is a set of topics linked and arranged around one key word. It is visualization, 

graphical presentation, of your ideas, thoughts or tasks. Topics inside your map are connected 

in different ways, forming a radial net with several branches and the central topic as connection 

point for all branches. Each branch from the map can be relocated to another position in the 

map, reattached to another topic or presented as separate map using the “Build as Map” 
feature. 

You can create different types of maps with iMindQ®, such as: Balanced/Free style Mind Maps, 

Organic Mind Maps, Concept Maps, Flowchart diagrams and other different, basic types of 

diagrams etc. Depending on what you want to create in iMindQ®, from the mentioned above, 

you have the following options in File Menu: 

 

Figure 56. File Menu options 

Create your First Map 

The next step, after the introduction with all features and their location in the ribbons, is to 

create a map. This small exercise will be practical introduction to IMindQ® main features and 

possibilities. You will create map that contains topics, floating topics, change topic’s shape and 
color, rearrange the order the topics in the map. 

The map, created by you, will have no more than 20 topics indented up to 4th level and 2-3 

floating topics.  At the beginning of this tutorial, you will learn how to insert topics and build 

a new map, to modify the content and the outlook of the topics, to choose and apply your 

own map style select the appropriate topic structure for the map and balance it.  

 Create a Mind Map 
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In the next headings you will learn how to: 

 Insert topics 

 Modify topics 

 Create map style, choose the topic structure, balance the Map and etc. 

 Balance a Map  

For that purpose, you have to fulfill the steps that are presented on the graphic below: 

 

Start New Map 

After starting iMindQ®, you will see the Introduction map, in which are presented all 

possibilities of the iMindQ® software. In order to start working with the application and create 

your first map you have to begin with blank map. For that purpose perform the following steps: 

1. Click on the File menu button.   

2. Point the mouse cursor on the New sub-menu 

3. From the available map types (Mind Map, Organic Mind Map, White Board, Org 

Chart and WBS Chart), select the one that is most appropriate for your work. 

 Tips: You can start a new map by using the “Cmd+N” shortcut. 

After performing the steps above, you will see the screen presented on the figure below. 

Insert
• Topics

• Floating Topics

• Callouts

• Relationships

Modify 

Topic
• Shape

• Color

Edit Map
• Style

• Strucure

Create •Present.

Balance 

Map
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Figure 57. New Map 

Insert Topics 

Topics are the main elements of the iMindQ® map. They can represent an idea, wish or task, 

process depending from the purpose of the created map. Detailed explanation of the topics 

in term of their definition, how you can use them in iMindQ®, how you can edit them is given 

in “Introduction” heading from this manual. 

To insert topic (sub-topic of existing one) i.e. to create parent-child relationship in the map 

perform the follow procedure: 

1. Select the topic that you want to add sub-topics (in this case the Central topic) 

2. Use the shortcut keys Cmd+Enter to insert the topic from the next level (Sub-

topics of the Central Topic) 

3. To insert new topic (level 3) use the Cmd+Enter button or if you want to add 

sibling topic use the Enter button on the keyboard.  

You can also insert subtopic to an existing topic, by using the Quick Menu which appears on 

mouse hover of a given topic. Insert subtopic by simply click, hold and drop. You can see how 

it is done in the figure below.  

 



 

 

 

 

 

 

58 iMindQ User Manual for Mac 

Figure 58. Insert Topic with Quick Menu 

To create the map you will insert: 

 4 topics in 2nd level 

 5 topics on 3rd level 

 7 topics on 4th level 

After several times performing the mentioned procedure, you will get the following map:  

 

Figure 59. Add Topics in the map  

 

Edit Topics 

When the map is created and it has the preliminary contour, it is time to give names to all 

topics inside it. You can use your own notification for the topics, but for this exercise we will 

use the following names (in clockwise order): 

Level Name 

2 Insert 

2 Modify 

2 Edit 

2 Present 

3 Topic 

3 Topic 

3 Style 

3 Color 
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3 Present your Mind Map automatically 

4 Color 

4 Black Velvet 

4 Blue Petrol 

4 Sunny Day 

4 Basic Color 

4 Custom Color 

4 My Color 

 

Format Topics 

To format a topic means to change the font of the text, text size and color, change the topic 

shape and shape color, line color etc. This can be done in several ways. It can be done by: 

 Clicking on the grey part of the Topic Menu that appears on mouse hover 

in one of the upper topic’s corners 

 Using formatting options from the dynamic Topic Format Ribbon, which appears 

after a topic is selected 

 Using formatting options from the main Format ribbon 

 

Edit Map Background 

When it comes to editing the Map Background, there are several things you can do with the 

Background of a Map: change Background color, add different Patterns in the Background 

from iMindQ library or insert Background Image. All these things are accessible via the Format 

Background dialog. 

To open the Format Background dialog, do the following steps: 

1. Right click on empty Map Space.  

2. From the Background context menu, click on the Format Background button.  

Add Patterns to Background 

In order to add Patterns to the Background you have to use the Library, Do the following steps: 

1. Click the Library panel on the right side of the space. 

2. Choose the Pattern tab. 

3. From the different folders select a Pattern of your preference.  
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Note: If you want to remove the Pattern from the Background, click on the ‘Clear Background 
Image of Map…’ button in the Library PanelPatterns Tab.  

 

Insert Background Image  

You can add Image to the Background by using the Format Background dialog. Here you can 

change the Position options of the image (Center, Fit and Tile), change its transparency and 

size. The image size can be enlarged by 10x more than its actual size and diminish it 10x less 

its actual size.  

 

Figure 60. Edit Background Image 

 

Create your own Map Style 

Map style feature allows you to change the outlook of your map by selecting one from the 

available styles or by creating your own style. After applying the appropriate style, you can 

make customizations of some topic, by changing the shape, color, font, etc. 

Define topic style 

To create your own topic styles for every type of topic in the map, you have to do the following 

steps: 

1. Select the topic that you want to modify (for Example, select the Central Topic); 

2. Make the necessary changes in term of modifying the font, font size, color, etc. 

3. Click on the Style button located on the far right side of the working area; 
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4. From the Style items drop-down menu select the appropriate topic style for 

which you have made changes (in step 1 we have modified the Central topic, so 

you have to select the Central Topic Style from the drop-down menu). 

5. Drag the mouse on the Central Topic style and from the drop-down menu select 

the Update style to match selection. 

6. Save the file in .dmms file format (iMindQ Map Style). 

 

Figure 61. Define Topic Style 

 

Import and apply topic style 

To apply the style that you have created into your map, first, you have to import the style and 

then to apply it in the map.  

To import the map style, perform the following steps: 

1. In the Style group of the Format ribbon click on the Style  drop-down icon; 

2. Select the Manage Styles… feature; 

3. Click on the Import button and browse the .dmms location; 

4. Close the Manage Style window. 

5. To import the map style, perform the following steps: 

6. Open map; 

7. Click on the Style button located on the far right side of the working area; 
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8. From the Map Style items drop-down menu select the topic style that you have 

created.  

Our new, refreshed map is presented on the figure below. 

 

Figure 62. iMindQ® map with implemented Map style  

 Tips: The same effect will be achieved if you use the same action located in the 

Format ribbon.  

 

Edit Map Style 

Map style or .dmms file can be edited as ordinary map. If you open a .dmms file, then iMindQ® 

will open in editing mode, containing only one ribbon that will allow you to make the necessary 

changes in the style. You can edit the following items: Central topic, Main topic, Floating topics, 

Subtopics, Callouts, Relationships and Boundary.  

To edit any of the mentioned map items, perform the following steps: 

1. Open the .dmms file, where the map styles are saved; 

2. Select the topic that you want to modify (for Example, select the Central Topic); 

3. Make the necessary changes in term of modifying the font, font size, color, etc. 

4. From the Style items drop-down menu select the appropriate topic style for 

which you have made changes (in step 1 we have modified the Central topic, so 

you have to select the Central Topic Style from the drop-down menu) 

5. Drag the mouse on the Central Topic style and from the drop-down menu select 

the Update style to match selection. 
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6. Save the modifications. 

Change Topic/Branch/Map Structure   

You can change the topic or map structure in several ways. To change the structure of a map, 

do the following steps:  

1. Select the Central Topic.  

2. Click on the Home Ribbon.  

3. From the Formatting group, click on the Topic Structure option.   

4. Choose one of the desired Topic Structures.  

Available Topic Structures: 

 Map  

 Four Direction Map 

 Split Tree 

 Left Map 

 Right Map 

 Top Map 

 Down Map  

 Right Tree 

 Left Tree 

 Free Layout  

In a balanced map not only that you can change structure of the entire map, you can also do 

it on the desired topic (branch). The Floating topics in a balanced map as well as the Main 

Topics of a Central Topic can be freely moved in a balanced map layout.  

You can apply the same map structure, mentioned above, to the Floating topics too. If you 

apply the topic structures listed below, to the Floating topics, they will become Central Topics. 

 Map 

 Four Direction Map 

 Split Tree  

 Free Layout 

This way you can create multiple mind maps in one iMindQ® document.  
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You can have multiple mind maps in one iMindQ® file with different map structures balanced 

map combined with free layout map and vise-versa. (See the image above) 

Freestyle Map Layout 

When you create a New Map it is balanced by default. Here, the positioning of the topics it is 

balanced and limited. With the Freestyle layout you can change their position anywhere in the 

map space.  

To apply freestyle layout to the map, perform the following steps: 

1. Select the central topic (My first Map). 

2. Click on the Format Ribbon tab. 

3. Click on Topic Structure dropdown menu and choose Freestyle . 

You can open a freestyle map with an interesting default map style from the File Menu  New 

 Organic Map. In the figure below, it is presented how a freestyle map will look like.  
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Figure 63. Freestyle map in iMindQ® 

Balance Map 

If we analyze the map for a bit, we can see that three branches are on the right side of the 

central topic (Insert, Modify and Edit) and one the Contents branch is on the left side. To do 

map symmetrical i.e. to have same number of branches from the both side you need to balance 

your map. 

To balance the map, perform the following steps: 

1. Select the central topic (My first Map) 

2. Click on the View ribbon tab.  

3. In the Map group, click on the Balance  icon 

4. The look of the balanced map is presented on the figure below. 

 

Figure 64. Balanced map in iMindQ® (tbc) 
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Split text information in a topic as new topics 

You can split a topic into multiple topics or multiple subtopics using spaces as a delimiter.  

When you have selected a topic, the user will be enabled to split the text in the topic: 

 As Multiple Topics – to create a group of new topics, all at the same level; 

 As Multiple Subtopics - to create a topic from the first word, with the other 

words as subtopics. 

1. Select the topic. 

2. Click on the Topic Format contextual ribbon tab.  

3. From the Structure group, click on the Split Topic  option.  

4. From the dropdown menu, either select As Multiple Topics or select As Multiple 

Subtopics.  

 Tip: You can use the same Split options from the contextual menu on right-mouse click 

on the topic. 

You can also use the following shortcut keys: 

 To split into multiple topics press Cmd+Alt+Enter. 

 To split into a topic with multiple subtopics press Cmd+Alt+I. 

You can split the topic at a particular location, using the text to the right of the cursor as text 

for the new topic(s). When you want to split the topic at a location where you have 

positioned the cursor, the following options are available:  

 As Topic – Split the text to the right of the cursor in a new sibling topic of the 

topic being split.  

 As Subtopic – split the text to the right of the cursor as a new child topic of the 

topic being split.  

 As Multiple Topics - the text is split at the cursor location, and then into 

additional new sibling topics using spaces as the delimiter. 

 As Multiple Subtopics - the text is split at the cursor location, and then into 

additional new child topics using spaces as the delimiter. 

1. Make a double click inside the topic at the location where you want to split it. 

2. Click on the Topic Format contextual ribbon.  

3. From the Structure group, click on the Split Topic option.  

4. From the dropdown menu select the desired splitting option.  

Click the topic type you want to create with the text to the right of the cursor. If you 

choose one of the "Multiple" options, the text is split at the cursor location, and then 

into additional new topics using spaces as the delimiter. 
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 Tip: You can use the same Split options from the contextual menu on right-mouse click 

on the topic. 

You can also use the following shortcut keys: 

 To split and create a sibling topic press Shift+Alt+Down arrow. 

 To split and create a subtopic press Shift+Alt+Right arrow. 

 

Organize your researched information 

In iMindQ®, you can search for information online in the same time as you are creating your 

map. As you type specific terms in the map, iMindQ® Research searches the information 

instantly and the searched results are presented to you in the preview window. If you need to 

search additional information for an existing topic, just select it and open the Research Panel. 

iMindQ®v will do the rest for you. 

You can filter your search by choosing one of the available options:  

 Google Search  

 Google Images 

 OpenClipart 

 Twitter 

To start searching, you shall open the Research Panel, positioned on the right side of the 

application window. The research panel is consisted of the following options:  

 Backward and Forward options to switch between already made searches; 

 Choose the desired search service: Google Search, Google Images, OpenClipart 

or Twitter; 

 Type what you search for in the edit box positioned in the top of the Research 

Panel; 

 Preview of the searched results; 

 Drag and drop desired content from the search results to the topics in the map 

space.   
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Figure 65. Research Panel in iMindQ® 

You can make drag and drop for different images and if you drop the desired image over a 

specific topic it will be added as an image in the topic.  

When you make a selection of a text and you drop that text over a specific topic, the selected 

text will be added as a subtopic. You can also add reference links to webpages that helped 

you while you were conducting a research. The dropped link to a webpage will be added as a 

subtopic to the topic where you dropped your selected hyperlink. See example below.  

 

Note: You can also use the copy and paste options available in the contextual menu that 

appears on right mouse click over the selected text, image, link or tweet.



 

 

 

 

 

69 iMindQ User Manual for Mac 

 

When you are working with large maps, it is very hard to find specific information that you 

might need. The only way to view the important information is to use a filter with different 

filtering criteria. iMindQ® enables you to filter topics by different topic elements (notes, 

attachments, hyperlinks), specific task information, images or icons used in the mind map, as 

well as search for topics with custom topic style applied in the map.   

In order to use the filtering options available in iMindQ®, do the following steps:   

1. Go to the View ribbon.  

2. From the Filter group, click on the Filter option.  

3. From the Filter dropdown menu, click on the Advanced Filter option. 

Once the Advanced Filter dialog opens up, you can see the different filtering options by which 

you can search specific topics within the map.  

 

Filter important info in large maps 
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Filter Important Info in Large Maps 

Filter tasks by different criteria 

In the filter dropdown menu, there are several, predefined task filter criteria. You can search 

for tasks that are not started yet, that are in progress or have been completed. When you want 

to be up-to-date with the progress of different tasks that are going to be due in the needed 

time interval, you can choose one of the available predefined task filters:  

 Tasks due in 1 day  - Tasks that need to be finished within the following day; 

 Tasks due in 1 week - Tasks that need to be finished within the seven days;  

 Tasks due in 2 weeks - Tasks that need to be finished within the following 2 

weeks;  

 Tasks due in 1 month - Tasks that need to be finished within the following month; 

and 

 Tasks due in 3 months - Tasks that need to be finished within the following three 

months.  

Below you can see examples for all available, predefined task filters. 

 
Example map of a project plan 
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Filtered tasks with % complete that falls in the interval of 51% – 75% 

 

 

 
Filter of tasks that are completed 
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Filter of tasks that are not started 

 

 

Filter of tasks that need to be finished within the following 7 days 

As we mentioned before you can filter information, by using additional filtering criteria. 

In order to do that, you need to open and use the options available in the Advanced 

Filter dialog. If you don’t want to use the predefined task filters, you can filter tasks by 
combining different tasks criteria together. For example you can search and filter tasks 

that start and finish on the same date.  
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Filter topics by different topic elements or a custom topic style 

If you have applied a custom topic style in the map, you can filter topics that have the 

custom style applied in the mind map.  

You can also view and filter topics that have one or a combination of all topic elements 

listed in the Advanced Filter dialog, such as:  

 Images and icons 

 Attachments 

 Hyperlinks 

 Notes 

 Alerts 

 Callouts 
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Present your Mind Map 

iMindQ® allows you to present your mind maps in a new and unique way, as well as in a very 

easy and fast manner. You can make an automatic presentations for your mind maps with just 

one click or make a custom presentations for specific audiences. You will be even able to 

interactively present different parts of your mind map, depending on the interaction and 

communication with the audience. For the first time, the concept of a screen play is presented 

in the mind mapping world, where your presentation is the screenplay, the scenes – view of a 

part of the maps in which different topics (actors) have their own animation (role) to play.  

Present your map automatically with one click 

At the end of a meeting, you might want to directly present what was concluded from the 

meeting, in a form of a mind map, to all attendees. You might need to present the Project WBS 

to the project team, in order to convey the main objectives of the project and what is expected 

as a project Deliverable  You can do that in iMindQ® with just one click.  

To present your mind map automatically, do the following steps: 

1. Click on the Present ribbon tab.  

2. From the Present group, click the From Beginning button.  

You can also use the shortcut key F5 to play the presentation automatically from beginning.  

An automatic presentation will be played in a Full Screen Presentation View. The flow of the 

presentation is represented in the figure below.  

 

Figure 66. Flow of automatic presentation for a mind map iMindQ® 

Present your maps & diagrams 
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You can present an Organizational Chart, Organic Mind Maps and WBS (Work Breakdown 

Structure), by following the same steps as described above with the difference in the flow for 

a top down layout of the maps. The flow for an automatic presentation for a WBS and 

Organizational Chart is presented in the Image below.  

 

Figure 67. Flow of automatic presentation for WBS in iMindQ® 

To play the next scene/animation in the Full Screen Presentation View, you can click on right-

mouse click , the Right Arrow key or Space. To exit the Full Screen Presentation View and end 

the presentation you can press Esc. If you want to switch the Full Screen Presentation Window 

to a second monitor, do the following steps:  

1. Use the shortcut Cmd + Right Mouse click. 

2. From the contextual menu, click on Leave Full Screen option.  

The size of the window will be restored and you can move the Presentation Window to another 

Monitor Display.  

 

Generate predefined presentation scenario for your mind map 

To generate predefined presentation scenario for your mind map, you will have to do the 

following steps: 

1. Click the Present ribbon tab. 

2. From the Scene group, click on the Generate Scenes button.  

The automatically generated scenes for your mind map, organic mind map, organizational 

chart or WBS will be inserted in the Scenes Panel on the left side. Each scene has a life preview 

of the topics animated in the specific scene.  
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The generated scenes in the Scenes Panel can be additionally modified/customized in the way 

that best suit your presentation needs. To play the automatically generated presentation 

scenario, click on the From Beginning button if you want to play the presentation from the 

beginning or click the option From Current if you want to play the presentation from the 

currently selected scene in the Scenes Panel.  

To play the presentation from beginning use the F5 shortcut key, and to play the presentation 

scenario from the currently selected scene use the shortcut keys Alt+F5. 

 

Make custom presentation for your Mind Map 

You can make a custom presentation for your Mind Map, Organic Mind Map, Organizational 

Chart or WBS by using template scenes and make custom modifications to the presentation.  

For mind map presentation the following template scenes might be used: 

 Focus on Topic – shows all elements and focuses on the Central Idea (Central 

Topic)  

 Expand Branch(es) Parallel – expands the selected branch(es) with all the child 

topics displayed at once and highlights each topic in sequence on click.  

 Sequentially Expand Branch– expands the selected branch(es) sequentially, one 

child topic at a time.  

 Show All Elements – display all elements of the mind map, to present the big 

picture of the discussed topic 

When you start talking about certain topic, you want to focus on it. That’s why Focus on Topic 

shall be used at the beginning of the presentations scenario.  

 

Add a Scene (Template Scene)  

To add a template scene, do the following steps: 

1. Select the Central Topic.  

2. Go to the Present Ribbon tab. 

3. From the Scene group, click on the Add Scene dropdown menu. 

4. Click on the Focus on Topic(s) template scene.  

Note: You can also create a scene, by dragging the selected topic(s) and dropping them in the 

Scenes Panel and from the contextual menu, choose the desired template scene.  

To present a specific branch and its child topics, use the Expand Branch template scene. Follow 

these steps: 
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1. Drag the desired branch to the Scenes Panel. 

2. Drop the branch in the Scenes Panel.  

3. From the contextual menu, choose Expand Branch(es) Parallel template scene. 

To display all elements of the mind map, use the Show All Elements template scene. Follow 

these steps: 

1. Go to the Present ribbon.  

2. From the Scenes group, click on the Add Scene dropdown menu. 

3. Click on the Show All Elements template scene.  

 

Change transition to a scene 

To change the transition of a scene, do the following steps: 

1. Select the desired scene.  

2. Go to the Present ribbon tab. 

3. From the Scene group, click on the Change Transition dropdown menu. 

4. Choose the desired transition (Pan or Jump To). 

 

Delete Scene(s)  

To delete a single scene, select the Scene in the Scenes Panel and press the shortcut key 

DELETE or do the following steps: 

1. Make a right mouse click on the desired scene.  

2. From the contextual menu, choose Delete Scene. 

3. If you want to delete a group of selected scenes, do the following: 

4. Make a multiple selection of topics by holding Cmd + Left mouse click. (You 

can use Shift +Left mouse click selection on the first and last topic of the group 

of scenes to be deleted). 

5. Press the shortcut key Delete.  

To delete all Scenes, use the shortcut keys Cmd+A and press the shortcut key Delete. 

   

Add Animation  

In a mind map, organic mind map, WBS or organizational chart, you can add animation in two 

ways to the selected item, depending on what you want to be animated with the selected 

element.  

You can add animation: 
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 On selected item(s) – Only the selected topic(s) are animated and included in 

the scene, without their child topics. 

 On child items – The selected branches are animated in the same time including 

their child topics.  

You can change how the animated topic should be treated, either as Parent Item or as Single 

Item.  

If you treat the animated topic as Parent Item, the parent and its child topics will be animated 

in the same time. The child topics will be animated only if you have previously expanded the 

parent branch.  

If you treat the animated topic as Single Item, only the parent or the selected item will be 

animated without its child topics.  

To change how a topic is treated in the animation, do the following steps:  

 Double click on the desired Animation in the Animations Panel, to view the 

animated topics.  

 Make a right-mouse click on the desired topic.  

 Go to the Treat As option in the contextual menu.  

 Choose one of the desired options, Parent Item or Single Item.  

You can add animation to selected topic(s), by doing the following actions: 

 Select the desired topic(s). 

 Go to the Present ribbon tab. 

 From the Scene group, click the Add Animation button.  

There is another alternative of how to animate topic(s). You will have to select the desired 

topic(s), drag them and drop them to the Animations Panel. You can set desired properties to 

a specific animation and you have the following options: 

 Animation Type 

 Effects 

 Start On – the animation can start on click, after the previous animation or with 

the previous animation.  

 Start After 

 Duration 

 Rewind Effect - rewinds the animation effect and returns the topic to its previous 

positions.  

 

Delete Animation 

To delete an animation, follow these steps:  
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1. Make a right mouse click on the desired animation. 

2. From the contextual menu, click on Delete Animation option.  

3. To delete a group of animations, do the following actions.  

4. Make a multiple selection of a group of animations with Cmd + Left mouse click. 

5. Press the shortcut key Delete.  

To delete all animations, make a multiple selection with Cmd+A and press the shortcut key 

Delete. Also you can delete all animations, by making right click in the Animations Panel View 

and from the contextual menu choose Delete All Animations.  

To change the order of an animation, drag the animation and drop it to the desired position 

in the Animations List in the Animations Panel.  

 

Play Presentation  

Play Presentation Scenario 

To play the presentation scenario, you have two options: 

 To play the presentation from beginning 

 To play the presentation from the currently selected scene 

To play the presentation scenario from beginning, do the following steps: 

1. Click on the Present ribbon tab. 

2. From the Present group, click on the From Beginning button.  

To play the presentation scenario “From Beginning” you can use the shortcut key F5. 

To play the presentation scenario from the currently selected scene in the Scenes Panel, do 

the following steps: 

1. Click on the Present Ribbon tab. 

2. From the Present group, click on the From Current button.  

You can also use the shortcut key Alt+F5 to play the presentation scenario from the currently 

selected Scene. To play next animation or next scene you have two options: 

 Right-mouse click   

 Use shortcut key Space 

 Right Arrow or Down Arrow keys. 

When you are Full screen Presentation View you can play the presentation by using the arrow 

shortcut keys.  
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 To play next scene/animation use the Right/Down arrow keys.  

 To go back to the last played scene from your current position in the Presentation 

scenario, use the Left/Up arrow keys. (When you go back to a last-played, 

previous scene, the application will just focus the presented topic/branch in the 

screen view).  

If you skipped several scenes from the Presentation and played one that was interactively 

selected, by using the Left/Up arrow shortcut keys, you can continue from your last played 

scene.  

While you are presenting in Full Screen Presentation View, you can open links and attachments 

in the default application of what is being opened. You can also view the Notes of a topic while 

you are presenting. To do so, click on the Notes icon of the desired topic and a pop up window 

will be displayed like in the image below. To close the Notes pop up window click anywhere 

on the screen, except the Notes window area.  

 

Figure 68. View Topic Notes while presenting 

Play Presentation Interactively 

To play a scene of a branch that is forward in the presentation scenario, do the following 

actions: 

 Select the desired topic/branch. 

 Make a Right Mouse click.  

The presentation will be continued from the selected scene. If you want to focus your view on 

already presented Scene, just select the played (animated) branch/topic and make a right 

mouse click. The system will just focus your view on the selected branch/topic. 
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If you want the play skipped step (topic, branch) from the presentation scenario, just select the 

desired topic and make right mouse click.  

When you are Full screen Presentation View you can play the presentation by using the arrow 

shortcut keys.  

 To play next scene/animation use the Right/Down Arrow keys.  

 To go back to the previous scene from your current position in the Presentation 

scenario, use the Left/Up Arrow keys. (When you go back to a last-played, 

previous scene, the application will just focus the presented topic/branch in the 

screen view).  

If you skipped several scenes from the Presentation and played one that was interactively 

selected, by using the Left/Up arrow shortcut keys, you can continue from your last played 

scene.  

Present your Flowchart diagram  

You can visualize your business processes in iMindQ® with a Flowchart diagram. After creating 

the Flowchart diagram, with iMindQ® you can easily make a presentation for your Flowchart 

diagram easily by using Template Scenes.  

Create a Presentation for a Flowchart Diagram 

To create a presentation for a Flowchart diagram, you will need to use the following three 

Template Scenes: 

 Focus on Topic(s) – hides all map elements and focuses on the one(s) you have 

selected 

 Present Sequence – fades in the selected topics in a sequence.  

 Highlight Presented Sequence – fades in the selected topics in the sequence 

and highlighting them as they fade in.  

 Show All Elements – shows all elements in the map, so the user can see the 

whole picture  

Here is an example flowchart diagram that we are going to use to create a presentation: 
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Figure 69. Example Flowchart Template in iMindQ® 

You can add a Template scene to a topic/topics in the following ways: 

 By using the Add Scene menu in the Present ribbon  

 By using drag and drop of topics to the Scenes Panel 

To add a template scene by using the Add Scene dropdown menu in the Present ribbon, do 

the following steps: 

1. Select the starting topic of the Flowchart diagram. 

2. Click the Present ribbon tab. 

3. From the Scene group, click on the Add Scene dropdown menu. 

4. Click on the Focus on Topic Template scene.  

To add a template scene by using drag and drop of topic(s), follow these steps: 

1. Drag the starting topic of the Flowchart diagram. 

2. Drop the topic to the Scenes Panel. 

3. From the contextual menu, choose Focus on Topic Template scene.  
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Figure 70. Focus on Topic template Scene – Flowchart diagram  

After focusing on the starting point of the Flowchart diagram, we will have to present specific 

flow or sequence. In this Flowchart diagram example, our first sequence to be presented will 

up to the decision point. To present the first flow, we will have to use the Present Sequence 

Template scene.  

Do the following steps: 

1. Make a multiple selection of topics by holding Cmd + Left mouse click, like in 

the image below.  

2. Drag the selected topics to the Scenes Panel and drop them. 

3. From the contextual menu, choose the Present Sequence Template Scene. 

 

Figure 71. Present Sequence template Scene – Flowchart diagram 
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Do the same steps until you finish presenting all the desired flows or sequences in the 

Flowchart diagram. For the example Flowchart diagram, all the sequences are presented in the 

image below.  

 

Figure 72. Flowchart diagram presentation flows 

At the end of each presentation, the presenter always wants to show the audience the big 

picture of what was discussed during the presentation and how everything is connected. In 

order to present all the elements of the Flowchart diagram, you will have to use the Show All 

Elements Template scene.  

Follow these simple steps: 

1. Click the Present Ribbon tab. 

2. From the Scene group, click on the Add Scene dropdown menu. 

3. Choose the Show All Elements template scene.  

Note: You can add Show All Elements template scene directly from the Scenes Panel. Make a right click 

on empty part of the Scenes Panel and from the contextual menu go to New Scene  Show All Elements.  

Here is how the custom presentation scenario for the example Flowchart diagram looks like in 

the Scenes Panel, by using Template Scenes.  



 

 

 

 

 

85 iMindQ User Manual for Mac 

 

Figure 73. Generated presentation scenario for Flowchart Diagram 

Present your Concept Map  

With concept maps you can visualize complex ideas and the interrelationships between them. 

They can be also used for knowledge sharing with others by giving meaning to the connections 

between what the presenter is trying to convey.  

Here is an example Concept Map template through which the process of creating a 

presentation for a Concept Map will be explained. You can make a presentation for a concept 

map in two ways: by using template scenes with predefined animations of the elements or by 

making a custom presentation from scratch.  

An example concept map is displayed in the image below.  
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Figure 74. Concept Map Example 

Create a Concept Map presentation by using Template Scenes 

In order to create a presentation for a concept map in a very fast and easy manner, we can use 

the following template scenes: 

 Focus on Topics(s) – hides all elements in the map and focuses on the topic you 

select as a starting point in the Concept Map. 

 Present Sequence – animated the concepts (topics) selected in a sequence that 

represents certain flow.  

 Highlight Presented Sequence – fades in the selected topics in the sequence 

and highlighting them as they fade in.  

 Show All Elements – Displays all elements of the concept map.  

In order to present what’s the main idea of the Concept Map, you will have to use the Focus 
on Topic template scene. To add the template scene, do the following scenario: 

 Select the starting topic of the Concept Map (main idea).  

 Click on the Present Ribbon tab. 

 From the Scene group, click on the Add Scene dropdown menu. 

 Choose the template scene Focus on Topic(s).  

To present a flow, follow the recommendations mentioned below:  

1. Select all the topics you want to be shown in the flow. 

2. Drag the selected topics and drop them in the Scenes Panel. 

3. From the contextual menu, click on the Present Sequence template scene.  
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Do the same steps for each flow you want to present in the presentation scenario. After you 

finish with creating a scene for all the desired flows from the Concept map, add the 

presentation scenario by adding the Show All Elements template scene. 

  

Make custom modifications to the Concept Map presentation 

The template scenes contain predefined animation with predetermined animation properties, 

which can be modified depending on your needs. You can modify the previous scenario by 

doing several things:  

 Add new animation in existing scene 

 Modify animation properties of existing animation 

 Change transition of Scene 

 Change the order of an animation  

 Change the order of a Scene  

 

Add new animation in existing scene 

In order to add new animation in an existing scene, you will need to select the desired scene 

in the Scenes Panel. The animations applied to the topics in the existing scene appear in the 

Animations Panel on the right side of the Application window. See the image below.  

 

Figure 75. A scene with applied animations to topics in the Scene 



 

 

 

 

 

88 iMindQ User Manual for Mac 

For our example, I want to add new Zoom In and new Zoom Out animation to starting idea 

(main idea) of the concept. To add a new animation in the Animations Panel in the existing 

scene, you can do the following steps:  

1. Select the starting point of the Concept Map (main idea).  

2. Drag it to the Animations Panel to an empty part or between two animations. 

(For our example, drag the topic after the second animation Fade In in the image 

above) 

3. Drop it between the Fade In and Focus animations.  

New Animation with Focus has been added in the Animations Panel. Set the following 

Animation Properties for the newly added animation:  

 Animation Type: Zoom In  

 Start on: With Previous 

 Duration: 2000ms 

Do the same steps to add a second animation between the Zoom In and No Effect Animations. 

Apply the following Animation Properties for the second animation:  

 Animation Type: Zoom Out 

 Start On: After Previous 

 Start After: 1000ms 

 Duration: 1000ms 

To preview the applied changes to the selected scene, go to the Scene Group  Preview Scene 

button. If you want to preview a specific animation, select the animation and click the Preview 

button in the Animations Panel.  

If you want to modify certain animation properties in a specific animation, select the animation 

in the Animations Panel and change the desired animation properties.  

To delete an animation, you can do the following steps: 

1. Make a Right Mouse Click on an animation. 

2. From the contextual menu, click on Delete Animation option.  

To delete all animations, follow these steps: 

1. Make a Right Mouse Click on any animation.  

2. From the contextual menu, click on Delete All Animations option.  

To delete specific animations, you have to make a multiple selection of the Animations in the 

Animations Panel and press the shortcut key Delete. 
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You can remove animated topics from one animation. In order to see which topics fall under 

specific animation, make a double click on the desired animation. After the topics are 

displayed, either make a right mouse click on the desired topic and select Delete Topic or use 

the shortcut key Delete.  

To change the order of an animation in the Animations list, drag the desired animation and 

drop it to the desired position.  
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Introduction 

What is topic? Topic is the key element of the map. Beside the connections that exist between 

all topics, forming parent-child relation, the topic is the “fundamental particle” of every map. 

With rectangular or round shape, in different colors and font styles they can present an idea, 

taught or task inside your map. 

According topic’s position within the map, iMindQ® has several types of topics: 

 Central Topic 

 Main Topic 

 Sub Topic 

 Floating Topic 

 Callout 

Central Topic 

The central topic is the starting point of building your map. When starting new map, the central 

topic is already placed in the map, and you start adding new topics around the central one. It 

is a special type of topic that cannot be copied inside the same map. Only one central topic 

exists in the map. You can also delete it from the map. There is no restrictions in positioning 

the central topic anywhere you want in the map space.  

Main Topic 

Main topic is the second level of the map. It connects the central topic with the rest of the map 

presented trough sub-topics and it is starting point of branching your ideas. Main topics can 

be added or deleted, copied and paste inside the existing map or in new one. Although they 

differ visually from the central topic (as its predecessor) and the subtopics (as successors), they 

possess same characteristic like the other topics in the map. 

Subtopic 

All other topics that are entered in the map after the main topic can be named as sub-topics. 

Depending from the position inside the map they can take different shapes but like the 

conclusion for the main topic, they have same characteristic like the other topics in the map. 

Floating Topic 

Floating topic is a topic that can be inserted without connection to the existing map. It can be 

considered as new central topic. It has the same properties as any other topic, except for the 

fact that a sibling topic cannot be added from it. Floating topic can have subtopics and callouts 

 Add various elements to the map 
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and can be moved through the map space. If you want, you can attach the floating topic 

somewhere in the map, so that it will no longer be a floating. 

Callout 

Callout is a descriptive topic and has the same properties as any other topic. It can be added 

to any element in the map except the Central Topic. By default, it is placed above the selected 

topic. Also, you can also add callout to external relationships when it is placed in the center of 

the relationship. 

Whenever a callout is added, you can immediately start writing text inside. There is limit on 

characters added in topics. 

 

Insert Topics 

You can insert topics in your map using one of the following methods that is appropriate for 

your work: 

 Using one of the available features from the Map Elements group in the Home 

ribbon; 

 Using the quick menu that appears on mouse hover on topic 

 Using one of the available features from the Map Elements group in the Insert 

ribbon; 

 Using the keyboard’s buttons (Cmd+Tab or Enter); 

 Using the Insert feature from the contextual menu. 

Enter button from the keyboard is used when you want to insert topic on the same level with 

the topic that you have selected. Example: If you want to add sibling topic to the Main Topic 1 

just select it and hit the Enter button. The result that you get is presented on Figure 76.  

 

Figure 76. Create sibling topic 
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Cmd+Enter button from the keyboard is used when you want to insert child topic to the 

selected topic (create parent-child relation). Example: If you want to add sibling topic to the 

Main Topic 1 just select it and hit the Enter button. The result that you get is presented on 

Figure 77. 

 

Figure 77. Insert child topic 

 

Insert Relationships 

The relationship between two topics can be used for visualizing the connection between two 

different topics or it can be used for defining the dependency when working with task 

properties (Project Management part in iMindQ®). 

There are several ways how to add a relationship between two topics: 

 Using one of the available features from the Map Elements group in the Home 

ribbon; 

 Using the quick menu that appears on mouse hover on topic  

 
 Using one of the available features from the Map Elements group in the Insert 

ribbon; 

 Using the keyboard’s buttons (Cmd+Shift+R); 

 Using the Insert feature from the contextual menu 

To insert relationship between two topics by using the Quick menu, you have to perform 

several steps: 

1. Point the mouse cursor over the topic that will be the starting point of the 

relationship. The topic will be rounded with gray colored border. 
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2. Click on the Relationship option, presented with the   icon, hold the left 

mouse button pressed and point the topic that will be the final point of the 

relationship. 

3. Placed the mouse cursor over the end-point topic (rounded with red colored 

frame) and released the left mouse button. 

 

Figure 78. Insert relationship with quick menu 

To connect two topics in the map, you can perform the following steps as well: 

1. Select the topic that will be the start point of the relationship (by default, marked 

on the topic with  symbol) 

2. Pressing the Cmd button select the topic that will be the end point of the 

relationship (by default, marked on the topic with  symbol) 

3. Click on the Insert ribbon 

4. From the Map Elements group, click on the  Relationship button. 

 

Figure 79. Insert relationship between topics 
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After you have inserted the relationship, you can edit the line that connects the topics. You 

can change the color, weight and pattern of the line, the styles of the beginning and ending 

points. This can be done in two ways: from the Format Relationship dialog (presented with 

figure 58) and from the Format Relationship dynamic ribbon (presented in the figure below). 

The Line Color in the Relationship Format ribbonLine Group after you have applied a custom 

line color to a map element, shall display the last applied Line color. If you have a relationship 

selected, and click on the Line Color dropdown menu, the line color of the selected relationship 

will be displayed.  

The same logic applies to the Relationship Shape option in the main Format 

ribbonFormatting group.  

The label of a relationship can be added by selecting the relationship and start directly typing 

the context of the label. When the label is entered, you can decide whether you want the label 

to follow the shape of the relationship. You can activate the Follow Line option by doing the 

following steps: 

1. Select a relationship.  

2. Click on the Relationship Format ribbon tab.  

3. From the Style group, click on the Follow Line option. 

Note: The same thing can be done from the Format Relationship dialog by selecting the Follow 

Line checkbox.  

 

Figure 80. Format Relationship dialog 
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Insert Boundary 

Boundaries in iMindQ® are used to group topics and visualize this group from the rest of the 

map. The grouping can be done by various criteria such as common idea, solution, etc. 

Inserting boundaries in the map is very easy: 

1. Select the topic in the map 

2. Click on the Insert ribbon tab.  

3. In the Insert group, click on the  Boundaries button 

 Tips: You can use the default boundaries that are available in the drop-down list 

from the Boundaries feature. If you want to make modifications on the look 

of the boundary, you have to use the Format Boundary dialog. 

 

Figure 81. Insert Boundary in map 

 Note: If you select topic that has sub-topics then all elements will be inside the 

boundary. 

After you have inserted the boundary, you can edit the style of the boundary. You can change 

the style of the boundary, the line color, weight and pattern, as well as the fill color and 

transparency. This can be done in two ways: from the Format Boundary dialog, or from the 

dynamic Format ribbon for Boundary.   

The Line Color in the Relationship Format ribbonLine Group after you have applied a custom 

line color to a map element, shall display the last applied Line color. If you have a relationship 

selected, and click on the Line Color dropdown menu, the line color of the selected relationship 

will be displayed.  

The Fill Color in the Boundary Format ribbonFill Group after you have applied a custom fill 

color to a map element, shall display the last applied fill color. If you have a boundary selected, 

and click on the Fill Color dropdown menu, the fill color of the selected boundary will be 

displayed.  

The same logic applies to the Boundary Shape option in the main Format ribbonFormatting 

group and in the Home Ribbon  Map Elements group.  
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Figure 82. Format boundary dialog 

You can insert multiple boundaries per topic, which is helpful when you want to visually 

present an intersection or common elements for two different sets or when you want to 

separate a subset of a bigger set of objects. Here are several examples:  

 

Figure 83. Subset of a set (Multiple Boundaries per topic) 

 

Figure 84. Subset of a set (Multiple Boundaries per topic) 



 

 

 

97 iMindQ User Manual for Mac 

Add objects to the topic 

Several types of objects can be attached to each topic from the map. These objects can be 

images from the iMindQ® library, different documents, hyperlinks or notes. Every object is 

visually presented with different icons in the topic and you don’t not need extra time to find 
out which topics have hyperlinks, notes or images. 

 

Insert Notes 

All comments, explanations, descriptions and details for one topic can be inserted in it using 

the Topic notes feature. In the notes area you can insert text associated with the topic, select 

the appropriate font and font size, text and highlight color, align and outline the text, etc. 

You can access the Topic notes by: 

4. Select the topic that you want to have notes. 

5. Click on the Home ribbon tab.  

6. In the Topic Elements group click on the  Notes button. 

Example for topic’s notes is presented on the figure below: 

 

Figure 85. Insert Topic notes 

 Note: The same action can be achieved using the same feature from the Insert 

ribbon or clicking on the Task Notes tab from the docked tabs. 
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Insert Image in Notes 

To insert an image in the notes, you shall do the following steps:  

1. Select the desired topic.  

2. Click on the Notes Panel on the right side of the application.  

3. Click on the Image button in the Notes editor.  

4. Specify the correct file location.  

5. Click OK. 

You can also change the size of the image you have already inserted in the Notes area. Make 

a right click on the image and click on the Size option.  

 

Figure 86. Image Size dialog in the Notes Editor 

 

Insert Table in Notes 

To insert a table in the notes area of a specific topic, you shall do the following steps:  

1. Select the desired topic.  

2. Click on the Notes Panel on the right side of the application.  

3. Click on the Table option.  

4. Specify the number of columns and rows of the table.  

Note: The Display Column Headings and the Display Row Headings options are not included 

in the total number of columns and rows that you specify.  
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Figure 87. Spreadsheet Properties dialog in Notes Editor 

You can also apply custom formatting to the table. To do so, follow these steps:  

1. Make a right click on the inserted table.  

2. From the contextual menu, choose the Format Table option.  

 

Figure 88. Format Table dialog in Notes Editor 
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Insert Hyperlink 

iMindQ® allows you to insert three types of hyperlinks: 

 Hyperlink to map on the web – link your topics from the map with the maps on 

Web IMindQ®. Do use this feature you will need premium account 

 Hyperlink to topic in map – this type of hyperlink allows you to link two topics 

from same map. It very useful feature when you work with large maps that 

covered great working area and you need to navigate constantly between two 

topics 

 Hyperlink to external object – link map’s topics with external documents, internet 
pages, folders or e-mails. 

The procedure for inserting hyperlinks is very similar with inserting notes; 

1. Select the topic to which you want to add hyperlink. 

2. Click on the Home ribbon tab.  

3. In the Topic Elements group click on the  Hyperlink button. 

In order to edit an existing hyperlink, make a right click on the desired link and from the 

contextual menu, choose the Edit Hyperlink option.  

 

 

Figure 89. Add Hyperlink to topic 
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Add Attachment 

If you need to attach specific file to the topic, you can use the Attach feature, located in the 

Home and Insert ribbon. To attach file to some topic from you map perform the following four 

steps: 

1. Select the topic that you want to attach file 

2. Click on the Home ribbon 

3. In the Topic Elements group click on the  Attach button 

4. In the newly opened window browse to the file’s location 

 

Figure 90. Add attachment to topic 

Insert Image 

iMindQ® helps you to visualize your ideas, your toughs. This visualization can be used not 

only for the entire map as one entity but also for its elements - topics. You can, for example, 

unify the use of images and icons for presenting common property for the topics. These 

images and icons can be inserted from the iMindQ® image library or imported. You can also 

drag and drop images from external and from the internal iMindQ® browser, either to a topic 

in the map or an empty map space. 

The following steps allow you to insert image in the topic: 

1. Select the topic to which you will insert the image 

2. Click on the Home ribbon tab.  

3. In the Topic Elements group click on the  Image button 

4. From the Library docking window – Image tab, select the location from which the 

image will be imported into the topic or just drag and drop the desired image. 
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Figure 91. Add image to topic 

Insert Icon 

The same explanation that is given for inserting images is valid for inserting icons. Once again, 

you can choose icon from one of the six available predefined icons packs (Number, Signs, 

Smileys, Office, Tasks and Other) or to work with the icons from the Professional folder.  

The following steps allow you to insert image in the topic: 

1. Select the topic to which you will add an icon.  

2. Click on the Home/Insert ribbon tab.  

3. In the Topic Elements group click on the  Icon button 

4. From Image tab select a specific folder from which you will insert your icon to 

the topic or in an empty space, but in that case you will skip step one.  
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Figure 92. Add icon to topic 

Add Custom Properties 

If you want to add and describe different properties of the content in the topic, you can do 

that by adding custom properties. These custom properties will describe different attributes 

of the content in the topic. The look and design of the custom properties is dependent on the 

formatting used for the topic and the text in it (fill color, body color and text font family and 

font size).    

To insert custom properties in the topic perform the following steps: 

1. Select the topic from the map. 

2. Click on the Insert ribbon tab. 

3. In the Topic Elements group click on the Properties button. 

4. Insert the desired name for the new property in the field “Type new property 

here…” 

5. Press ENTER. 

The custom property will be added in the topic. You can change the data type of the property, 

and you have the following options: Text, Number, Date, Time, Date & Time, and Boolean. Also 

you can change and edit the property value within the topic and in the Custom Properties 

panel. 
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Figure 93. Add custom properties to topic 

If you want to save time on creating the same property again and specifying their data type, 

you can choose an existing custom property in the map, by choosing the desired property 

from the recent list that appears when you enter new or you edit existing Property Name.  

 

Figure 94. Custom Property Recent List 

Insert Spreadsheet 

To insert a Spreadsheet in a topic, you will need to do the following steps: 

1. Click on the Insert ribbon. 

2. From the Topic Elements group, click on the Spreadsheet button. 

3. In the Spreadsheet Properties dialog, specify the desired number of columns and 

rows. 

You can enter basic formulas in the Spreadsheet, such as: 

 Sum - SUM 

 Average - AVERAGE 

 Minimum - MIN 

 Maximum - MAX 

 Count - COUNT 
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To use one of these formulas, will need to select the desired range and make a right mouse 

click. From the context menu, go to the Formulas option and choose the desired formula. The 

result will always be displayed at the bottom of the selected range. 

If you want to get the result of a the desired formula in other cell, rather than below the 

selected range, you will need to do perform these steps: 

1. Select the desired cell. 

2. Type the following parameter values: 

=FUN(Range Cell 1:Range Cell X); 

  

Ex. =SUM(B1:B3) 

 

Ex. =AVERAGE(B1:B3) 

 

Ex. =COUNT(B1:B3) 
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Ex. =MIN(B1:B3) 

 

Ex. =MAX(B1:B3) 
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Balance Map 

Balance Map feature allows you to align the topic in the map. Sometimes, during your work 

on the map, you will relocate the sub - topics around the parent topic. Make space for the new 

topics, add missed topics are few examples how the symmetry of the map can be disturbed. 

To “fix” this issue and have visually nice and esthetical map, you can use the Balance Map 

feature. Using this iMindQ® element, the child topics will be equally distributed around the 

parent topic. Let’s see this trough example: 

From several reasons the symmetry in our topic’s sub-tree is disturbed by adding several new 

topics. 

 

Figure 95. Unbalanced map 

To balance the map and bring order in the sub-tree, perform the following steps: 

1. Select the topic from the map (in our case  

2. Click on the View ribbon tab.  

3. In the Map group click on the  Balance button 

4. From the drop-down menu you can select whether to balance topic or subtree 

The result from this action is presented on the figure below: 

 

Figure 96. Balanced Map 

 Stylized Map Layout 
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Focus on Topic 

As mentioned before, in the introduction part, iMindQ® map can contain several hundred 

topics (example: My First Map). If you know the topic that you want to emphasize, Focus on 

Topic feature can help you to do that. Instead of scrolling and navigating through the map 

and zooming with just one click, the desired topic will be in the center of the screen zoomed 

to the appropriate level. 

With one click on the Focus on Topic feature (View tabMap group Focus on Topic) the 

desired topic will be in the focus, zoomed and positioned in the center of the screen. 

Center Map 

The “Center Map” functionality is same as the “Focus on Topic”. Clicking on this feature located 
in the Map group, placed in the View ribbon, the focus will be put on the Central Topic i.e. this 

topic will be in the center of your screen. 

Build as Map 

“Build as Map” feature created a new map with the selected topic as central topic and its 

branches as main topics and subtopics. This is very suitable to use it when you want to 

developed one branch from the existing map in new map, with more details compared with 

the previous one. 

To create new map from existing one, follow then next procedure:  

1. Select the topic that will be the central topic in the new map. 

2. Click on the Insert ribbon tab.  

3. In the Map group click on the  Build as Map button. 

 Tip: If the root topic is related with other topic from its branch with a 

relationship, that relationship will not be shown in the new map.  Also, if 

the root topic is in a boundary from a parent topic, that boundary will not 

be shown in the new map  

Map Parts 

For using same topic tree structure on several locations in the map or in another map, use the 

“Map Parts” feature. This feature allows you to save the selected map sub-structure in the Map 

Parts tab from the docking windows panel and use it in the opened maps. You can insert saved 

parts in other maps, modify them, rename it or delete it.  
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The Map Parts are categorized in three main categories, depending on the user’s need: 
Business, General and Personal. In the Business category, there are additional subcategories: 

 Brainstorming 

 Business General 

 Marketing 

 Meetings 

 Planning 

 Project Management 

 Quality Assurance 

For example: the branch will be used in several maps. It is universal subtree arrangement that 

will represent same process, idea, information flow in all maps.  

1. Select the topic from the map that will be copied in the Map parts library.  

2. Click on the Insert ribbon tab.  

3. In the Map group click on the  Map Parts button. 

4. In the Map Parts library click on the Add Selected Topic(s) option.  

 

Figure 97. Map Parts Panel and Map parts categorization 

Now to use this part in another map perform the following steps: 

1. Select the topic from the map that will be parent topic for the saved map parts.  

2. Select the map part that will be added in the new map. 
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3. Right click on the mouse button and select the Insert as New Topic feature from 

the contextual menu. 

You can also rename an existing Map Part, in two ways:  

 Select the Map Part that you want to rename, and directly start typing the 

changes. 

 Click on the dropdown menu of the existing Map Part and click on the Rename 

option.  

 

Figure 98. Map Parts Panel and Map parts categorization 

Rearrange topics in the map 

Mind map is dynamic system. The represented idea, task or projects evolves and the number 

of sub-topic, topics and branches increase. Thus, sometime during map’s creation or before 
important presentation you need to re-arrange the topics or branches in order to emphasize 

particular idea or path. You can also apply different spacing between topics.  

The following rearrangement process refers to a balanced map. In the rearranging process, 

the main point is to follow the red indicator that appears under the selected topic ( ) 

and informs you about the current position and the final result of the moving procedure if you 

release the mouse button in that moment.  

To show you how easy is to rearrange topics and branches in iMindQ®, the following examples 

will be presented: 

Example 1. The generic mind maps is created and it is presented on Figure 99. 

 

Figure 99. Map before rearrangement 
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As it can be seen form the image, the left side of the map is “empty” and contains only one 
branch while the right side contains four branches. The map is dis-balanced and the visual 

effect is not very good. The task that you want to perform is to rearrange the map and move 

the branch that contains the “Map Main Topic 4” on the left map’s side. 

To do this, perform the following steps: 

1. Click on the “Map Main Topic 4” and hold the right mouse button 

 

Figure 100. Select topic 

2. Move the branch toward “Map Main Topic 5” and position it above it. 

 

Figure 101. Move the topic across the map 

3. Release the mouse button. 

 

Figure 102. Rearranged map 
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Example 2: The second example is little complicated compared to the first one. Branch that 

contains “Map Main Topic 3” is important and you want to relocate it between Branches 1 and 

2.  

To rearrange the map and move “Map Main Topic 3”, perform the following steps: 

1. Click on the “Map Main Topic 3” and hold the right mouse button 

 

Figure 103. Select topic 

2. Move the selected branch upward and position it between the “Map Main Topic 1” and 
“Map Main Topic 2”. Move the selected topic toward the “Central Topic” in order “Map Main 
Topic 3” to touch it (in that moment red line will appear around the Central Topic ), as it is 

presented on the figure below.  

 

Figure 104. Place the topic on the desired position 

Note: Working on this way you will ensure that you have relocated the topic properly. If you 

don't “touch” the Central Topic, the application will attach the “Map Main Topic 3” on the first 
or second branch depending where the red indicator is positioned. 

3. Release the mouse button. 

 

Figure 105. Final look of the map 
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Example 3: The last example is to rearranging the sub-topics in the third branch. Let’s rearrange 
them in the following order 

 Sub-topic 3.1 

 Sub-topic 3.3 

 Sub-topic 3.2 

To rearrange the sub-topics inside the branch, perform the following steps: 

1. Select the “Sub-topic 3.3” 
2. Position the sub-topic between “Sub-topic 3.1” and “Sub-topic 3.2” and with the left lower 

corner “touch” the “Sub-topic 3” 

 

Figure 106. Move it to the desired location 

3. Release the mouse button. 

 

Figure 107. Final look of the branch 

You can rearrange topics within the same level by using shortcut keys: Ctrl + “” for moving 
a topic one place up and Ctrl + “” for moving topics one place down.  

Spacing between Topics 

You can manage the horizontal and vertical spacing between topics in map with five different 

levels of spacing in each category (horizontal/vertical). The enumerations are 1x (Default), 2x 

(200%), 4x (400%), 8x (800%) and 16x (1600%) from the default spacing. The spacing is applied 

to the entire map (if the central topic is selected) or to a specific branch.  To manage the 

spacing between the topics, do the following steps: 

1. Select a topic. 

2. Go to Format/Topic Format ribbon tab.  
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3. From the Adjust group, click the Spacing button and choose a vertical/horizontal 

spacing option(s) from the dropdown menu.  

These are the combinations of the different horizontal spacing if the selected topic is the 

central one.   

 

Figure 108. Default 1x Horizontal Spacing applied to the Central Topic  

 

 Figure 109.  Horizontal 2x Spacing applied to Central Topic 

 

Figure 110. Horizontal 4x Spacing applied to Central Topic 

 

Figure 111. Horizontal 8x Spacing applied to Central Topic  

 

Figure 112. Horizontal 16x Spacing applied to Central Topic 

 

The figures that follow are the combinations of the different vertical spacing if the selected 

topic is the central one.    

 

Figure 113. Default 1x Vertical Spacing applied to the Central Topic  
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Figure 114. Vertical 2x Spacing applied to the Central Topic  

 

Figure 115. Vertical 4x Spacing applied to the Central Topic  

 

Figure 116. Vertical 8x Spacing applied to the Central Topic  

 

Figure 117. Vertical 16x Spacing applied to the Central Topic  

Alignment of Topics  

The alignment of topics is available only when you work with White Board space and with 

Freestyle Map Layout. To enable this functionality, you have to select more than one topic. The 

alignment will be applied to the last created topic. There are several alignment options: Align 

Left, Align Center, Align Right, Align Top, Align Middle and Align Bottom.  

To align specific topics, you need to the following steps: 

1. Select the topics you want to align. 

2. Click on the main Format ribbon tab or to the Topic Format ribbon tab. 
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3. From the Adjust group click the Align button and choose some of the alignment 

options.  

Here are examples for each alignment functionality, presented on the figures below.   

 

Figure 118. Left Alignment by the last created Topic 

 

Figure 119. Right Alignment by the last created Topic 

 

Figure 120. Center Alignment by the last created Topic 

 

Figure 121. Top Alignment by the last created Topic 
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Figure 122. Middle Alignment by the last created Topic 

 

Figure 123. Bottom Alignment by the last created Topic 

Distribution of topics horizontally and vertically 

You can also distribute topics in even horizontal or vertical distances from each other. In order 

this function to be enabled you need to select at least three topics, objects and this feature 

only is enabled only in White Board.  Do the following steps. 

1. Select at least three topics. 

2. Go to the Format/Topic Format ribbon tab.  

3. From the Adjust group, click on the Align button and from the dropdown menu choose 

either ‘Distribute Horizontally’ or ‘Distribute Vertically’.  

 

 

Figure 124. Horizontal distribution of topics 
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Figure 125. Vertical distribution of topics 

Z - Ordering of elements 

You can also assign different order to the topic(s) in the map. You can assign different order 

to the topic(s) in the map, having four different ordering options:   

 Bring to front - Bring the selected topic(s) in front of all other topics. 

 Bring Forward - Bring the selected topic(s) forward one level so that it's/they’re 
hidden behind fewer topic(s). 

 Sent to Back - Send the selected topic(s) behind all other topics.  

 Send Backward - Send the selected topic(s) back one level so that it's/they’re hidden 
behind more topics. 

If you want to bring a topic in front of all other topics, do the following steps:  

1. Select the topic(s) in the map. 

2. Click the main Format ribbon tab or the contextual Topic Format ribbon tab (appears 

when the topic is selected). 

3. From the Adjust group, click the button  Bring to Front.   

Tip: The same thing can be done on right click on a selection from the contextual menu.  

 

Figure 126. Bring a topic in front of all other topics 

If you want to bring a topic forward to be one level closer to the front, do the following steps:  

1. Select the topic(s) in the map. 
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2. Click the main Format ribbon or the dynamic Topic Format ribbon (appears when the 

topic is selected). 

3. From the Adjust group, click the button  Bring Forward.   

Tip: The same thing can be done on right click on a selection from the contextual menu.  

 

Figure 127. Bring a topic one level forward 

If you want a topic to be sent to back, behind all topics, do the following steps:  

1. Select the topic(s) in the map. 

2. Click the main Format ribbon or the dynamic Topic Format ribbon (appears when the 

topic is selected). 

3. From the Adjust group, click the button  Send to Back. 

Tip: The same thing can be done on right click on a selection from the contextual menu.  

 

Figure 128. Sent topic to Back  

If you want a topic to be sent one level backward, do the following steps:  

1. Select the topic(s) in the map. 

2. Click the main Format ribbon or the dynamic Topic Format ribbon (appears when the 

topic is selected). 

3. From the Adjust group, click the button  Send Backward. 

Tip: The same thing can be done on right click on a selection from the contextual menu.  

 

Figure 129. Sent topic Backw
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Make a Flowchart in iMindQ 

Mind Map 

What is map? Map is a set of topics linked and arranged around one key word. It is visualization, 

graphical presentation, of your ideas, thoughts or tasks. Topics inside your map are connected 

in different ways, forming a radial net with several branches and the central topic as connection 

point for all branches. Each branch from the map can be relocated to another position in the 

map, reattached to another topic or presented as separate ma. 

You can create different types of maps with iMindQ®, such as: Balanced/Freestyle Mind Maps, 

Concept Maps, Flowchart diagrams and other basic types of diagrams etc.  

A Mind Map is a diagram used to visually outline information. A mind map is often created 

around a single word or text, placed in the center, to which associated ideas, words and 

concepts are added. 

Major categories radiate from a central topic, and lesser categories are sub-branches of larger 

branches. Categories can represent words, ideas, tasks, or other items related to a central key 

word or idea. 

 

Figure 130. Mind Map 
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Concept Map 

A Concept Map is a way of representing relationships between ideas, images or words in the 

same way that a sentence diagram represents the grammar of a sentence. In a concept map, 

each word, phrase, or idea connects to another, and links back to the original idea, word or 

phrase. Concept maps are a way to develop logical thinking and study skills by revealing 

connections and helping people see how individual ideas form a larger whole.  

A well-made concept map grows within a context frame defined by an explicit "focus 

question".  

The concept maps (spider concept maps, flowcharts, system concept map), other diagrams 

can be created in the White Board space. Do the following steps: 

1. Click the File Menu. 

2. Go to New and click on the  WhiteBoard button. 

 

Figure 131. Spider Concept Map 

 

Figure 132. Flowchart Diagram 
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Concept Maps vs. Mind Maps 

Because of the different origins and purpose of each, Mind Maps and Concept Maps have 

complementary strengths.  

 Mind maps can grow much larger than Concept Maps. Concept maps (networks) 

get exponentially more awkward as they scale up, whereas trees can scale up very 

well, because they encapsulate larger amount of information (mind mapping term 

collapse branch).  

 Mind Maps are used mainly to generate ideas more quickly.   

 Mind Maps are much better at visually and mentally dividing things up into different 

contexts and areas of focus. A Concept Map is more usually considered as a whole, 

which is another reason that Concept Maps tend to remain smaller.  

 Concept Maps are designed to be clearly read one proposition at a time, whereas 

many Mind Maps can only be skimmed to give a flavor of the subject, or even just 

visually appreciated as a work of art. 

 Mind Maps work well as a reminder for those "in the know". Concept Maps are self-

contained and self-explanatory, so are better suited to sharing real knowledge with 

non-authors, without a limited shelf life.  

 Concept Maps visualize systems, something that is hard to do in tree diagrams.  

 

Create a Flowchart diagram 

A flowchart is a type of diagram that represents an algorithm or process, showing the steps as 

boxes of various kinds, and their order by connecting them with arrows. This diagrammatic 

representation illustrates a solution to a given problem. Process operations are represented in 

these boxes, and arrows; rather, they are implied by the sequencing of operations. Flowcharts 

are used in analyzing, designing, documenting or managing a process or program in various 

fields. 

Flowcharts are used in designing and documenting complex processes or programs. Like other 

types of diagrams, they help visualize what is going on and thereby help the viewer to 

understand a process, and perhaps also find flaws, bottlenecks, and other less-obvious 

features within it. There are many different types of flowcharts, and each type has its own 

repertoire of boxes and notational conventions.  

As a rule of thumb, flowcharts always start either from left to right or top to bottom. The reason 

for this is clarity. 
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iMindQ® allows you to create flowchart diagrams very easy. The first thing you need to do is 

open a Whiteboard space from the File Menu  New. All the commonly used boxes for 

creating a flowchart diagram, are placed in a specific folder in the Library panel  Shapes tab.  

 

Figure 133. Flowchart diagram folder containing commonly used shapes 

The commonly used notations in a flowchart diagrams are represented in Figure 134.  

 

Figure 135. Meaning of the flowchart diagram shapes  

To insert a shape in the map space, simply drag and drop a shape from the Shape Library 

anywhere you want in the map.  
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To connect two shapes you can use the Topic menu, like in the figure below. You can put a 

label to the relationship as well.  

 

Figure 136. Connecting two shapes with an arrow (relationship)  

 

Figure 137. Labeling a relationship between two shape
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Introduction 

What is project? According the “PM Body of Knowledge” project is “temporary endeavor 
undertaken to create a unique product, service or result”. PRINCE 2 methodologies define the 
project as "a management environment that is created for the purpose of delivering one or 

more business products according to a specified business case". If you search the World Wide 

Web, you can find more definitions for project or project plan. You don’t need to know all 
these terms in order to make or to manage one project plan. Just remember that project is 

something that has start and finish, and deliver material or nonmaterial goods. 

One good example for project is shopping at the local supermarket. Although it seems too 

trivial as example, actually you will find that it is not as simple as it looks like. At the beginning 

you are defining the timeframe for the shopping, keeping in mind the supermarket’s working 
hours and the time needed for going to the mall and for shopping. Next, you are writing on a 

piece of paper the product that you will buy and prioritize them. The last step is planning the 

budget i.e. how much money you are planning to spend for shopping. Of course, there is 

always a backup plan in case something goes wrong. After fulfilling these steps, you are ready 

for spending some money. 

As you can see, this example contains the main characteristics for one project: timeframe, 

planning, prioritizing, budgeting and backup plan. You can use the same technique for 

creating projects in iMindQ® but instead organizing entire process in your mind and writing 

it on a piece of paper you will use views and other features for better and faster creation of 

projects. 

Tasks and resource will be introduced in this chapter, since they are basic elements of any 

project plan. 

Gantt Chart 

Gantt chart view is the most used view while creating project. It gives tabular and graphical 

presentation of the tasks in the project plan. Gantt chart view consists of two parts: Gantt Table 

which is located on the left side of the application and Gantt chart on the right side.  

Gantt Table (or Gantt Sheet) consists of columns that contain information for the tasks. 

Depending on which table you are working, different columns will be presented in the Gantt 

Sheet. A default table for the Gantt chart is the Entry table. Task’s attributes can be entered in 
the Gantt Sheet by typing the appropriate information in the cells, selecting from the drop-

down list in the cell or by using the Task Info window. 

Create and track project plans 
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The look of the Gantt chart view is presented on the figure below. 

 

Figure 138. Gantt chart view in iMindQ® 

Gantt chart contains bars that are graphical presentation of the tasks entered in the Gantt 

Table. The length of the bar corresponds to the task’s duration. At the top of the Gantt chart 
is the timescale with two layers. The bottom layer presents the working days in the week and 

the top layer presents the working weeks in the year. The non-working days are colored blue. 

The Gantt chart has gridlines for background in order to help you in determining starting or 

finishing day of some particular task or to view task’s duration. 

You can use the Gantt chart for: 

 Planning and Organizing project plans to the  

 Monitoring project’s progress 

Task 

There are several symbols that represent task in iMindQ®. The task’s bars that are used in 
Gantt chart view and their description can be found in the table below: 

Bar Description 

 
Summary Task 

 Task 

 Milestone 
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Summary Task can be graphical symbol for one group of tasks that are logically connected or 

can be representation for project summary task. When representing one group of tasks, 

Summary Task summarizes the information for duration, progress and costs for the tasks. 

Milestone is a task that represents achieving major point in the project. Characteristic for this 

type of task is the duration. Milestone has 0-day duration and it can hardly be considered as a 

task since they are point in time. You can use milestones to emphasis the breaking points 

(major releases of product, starting marketing and sales campaign, etc.) when you present the 

project plan in front of the upper management in your company. 

Dependencies 

After you entered the task, you need to connect the tasks in order to get visual flow of the 

project plan. You can link tasks on several ways: by selecting tasks in Gantt Sheet and clicking 

on the  icon in the Standard toolbar; using the Link Task function in the Edit menu; connect 

tasks using the connector in the Gantt chart. If you use one of these possibilities for linking 

tasks, they will be connected with Finish to Start dependency because this is a default 

dependency in iMindQ® 

iMindQ® has the following dependencies: 

 Finish to Start (FS) 

 Start to Finish (SF) 

 Start to Start (SS) 

 Finish to Finish (FF) 

 

Finish to Start (FS) 

Finish to Start is a default dependency in iMindQ®. This means that the successor task cannot 

start until the predecessor task finishes. The line’s arrow that connects two tasks is pointed 

from the task that is assumed to be predecessor (task’s Finish Date) to the task that is successor 

(task’s Start Date). 

For example, there are two tasks: Task Blue and Task Red, connected with Finish to Start 

dependency, as it is presented on Figure 139. Finish to Start dependency determines that the 

Task Red cannot start until Task Blue is 100 % complete. Also, you can notice that the arrow is 

pointed from the Task Blue Finish Date (predecessor) to the Task Red Start Date (successor). 

 

Figure 139. Example for Finish to Start dependency 
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Start to Finish (SF) 

Next dependency that is supported by iMindQ® is the Start to Finish, where the successor task 

cannot finish until the predecessor task starts. The Finish Date of the successor task can be 

equal or greater than the Start Date of the predecessor task: 𝑆𝑢𝑐𝑐𝑒𝑠𝑠𝑜𝑟(𝐹𝑖𝑛𝑖𝑠ℎ 𝐷𝑎𝑡𝑒) ≥ 𝑃𝑟𝑒𝑑𝑒𝑐𝑒𝑠𝑠𝑜𝑟(𝑆𝑡𝑎𝑟𝑡 𝐷𝑎𝑡𝑒)  
The link that connects the task starts from the predecessor’s Start Date and ends at the 

successor’s Start Date. 

 

Figure 140. Example for Start to Finish dependency 

Let’s see the Start to Finish dependency trough example. On Figure 140 Task Red cannot finish 

until Task Blue starts. This means that Task Red can finish on the same date when Task Blue 

starts, or later. The dependency link starts from Task Blue Start Date and ends to Task Red 

Finish Date. 

 

Start to Start (SS) 

Another dependency in iMindQ® is Start to Start dependency. Definition for this dependency 

is: “The successor task cannot start until the predecessor task starts”. Tasks may or may not 

have the same Start Date. The successor task may start at any time after predecessor task starts, 

or expressed with equation: 𝑆𝑢𝑐𝑐𝑒𝑠𝑠𝑜𝑟(𝑆𝑡𝑎𝑟𝑡 𝐷𝑎𝑡𝑒) ≥ 𝑃𝑟𝑒𝑑𝑒𝑐𝑒𝑠𝑠𝑜𝑟(𝑆𝑡𝑎𝑟𝑡 𝐷𝑎𝑡𝑒) 

The arrow that connects these tasks is pointed from predecessor’s Start Date to successor’s 
Start Date.  

Once again, let us see the example with the Task Blue and Task Red, presented on Figure 141. 

According to the definition, Task Red cannot starts until the Task Blue starts. Also, you can 

notice that the arrow is pointed from the Task Blue Start Date (predecessor) to the Task Red 

Start Date (successor).  

 

Figure 141. Example for Start to Start dependency 
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Finish to Finish (FF) 

The last dependency in iMindQ® is Finish to Finish. This means that the successor task cannot 

finish until the predecessor task finishes. Tasks may or may not have identical Finish Date. The 

successor task can finish at any date after predecessor task’s finish. Expressed with equation: 𝑆𝑢𝑐𝑐𝑒𝑠𝑜𝑟(𝐹𝑖𝑛𝑖𝑠ℎ 𝐷𝑎𝑡𝑒) ≥ 𝑃𝑟𝑒𝑑𝑒𝑐𝑒𝑠𝑠𝑜𝑟(𝐹𝑖𝑛𝑖𝑠ℎ 𝐷𝑎𝑡𝑒) 

The line arrow that connects these two tasks starts from predecessor task’s finish date and 
pointed to successor task’s finish date. 

On the figure below are presented two tasks connected with Finish to Finish dependency. Task 

Red can finish at any date after Task Blue is 100% complete. You can see that the connection 

line starts at Task Blue Finish date and ends at Task Red Finish Date. 

 

Figure 142. Example for Finish to Finish dependency 

 

Create Task in iMindQ® 

After the introduction with the main elements of the Project Management and iMindQ® 

project management features, you are ready to create tasks from the topics and create project 

plans. 

Topics are modified into tasks using the Task Info feature: 

1. Select the topic from the map that will be transformed into task 

2. Select the Insert ribbon tab.  

3. In the Task Elements group click on the Task Info button 

4. In the Task Info panel enter the Start Date for the Task.  

These four steps are enough to create task and this task to be presented in Gantt chart (View 

ribbonViews groupGantt chart) 

Now, you can create tasks from the Plan ribbon too and see how they are created directly in 

the Gantt chart. Do the following steps: 

1. Click on the Plan ribbon tab.  

2. Select a topic. 

3. Click on the Task button.  
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Note: If you continue to click the same button and the same topic (task) is selected in the map, 

the newly tasks will be topics (tasks) on the same level as the selected. This is presented in the 

figure below.  

 

Figure 143. Create task in iMindQ® from Plan ribbon 

Set a Mind Map branch into Project Branch 

In a Mind Map you can set a branch as Project Branch and make initial plans by further 

branching it out. The Project Branch is a summary task and is directly represented in the Gantt 

Chart View.  

To transform an ordinary branch into Project Branch, do the following steps: 

1. Select the desired branch. 

2. Click on the Plan Ribbon tab.  

3. From the Insert Group, click on the Project Branch button.  

 

Figure 144. Transform a Branch into a Project Branch 
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Edit Task 

You can edit tasks parameters in your project in several ways: 

 Using the Task Info panel 

 Using the Gantt table 

 Using the Gantt Chart 

 Using the Task Info dialog 

Use the method that is most appropriate for you. 

 

Edit task using Task Info panel 

Using the Task Info panel, you can define and edit the Start and Finish Date of the task, update 

task’s progress through % Complete and prioritize the task using the Priority field. This 

information is as much as necessary to create one task. The required values can be entered 

using the calendar for Start and Finish Dates, a symbol near fields for increasing or decreasing 

the value or by typing the value in the field. 

The look of the Task Info panel is presented on the figure below. 

 

Figure 145. Edit task using Task Info 

 

Edit task using Gantt table 

Another option for editing tasks is by typing the tasks’ names or values directly in the sheet. 
For this purpose you can use the Gantt table part from the Gantt Chart view. You can edit 

task’s names, Start and Finish dates, Duration and Predecessors. 
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Part of the editing process of the task (example: Start Date) is presented on the figure below. 

 

Figure 146. Edit task using Gantt table 

 

Edit task using the Gantt Chart 

The easiest and the fastest way to edit a task is to use the Gantt chart. Point the mouse cursor 

at the day that will be start date of the task, click on the left-mouse button and draw the length 

of the task, as it is presented on figure below. 

 

Figure 147. Start editing task from Gantt chart 

When the left-mouse button is released, the task is created, ready for editing and incorporating 

in the project plan. Using this method for drawing tasks and connecting them with task 

dependencies (presented in next section), you can create entire project plan in a very short 

period of time. All you have to do afterwards is to give a name to the tasks. The final result of 

the editing process is presented below. 
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Edit task using Task Info dialog  

Now with the new Plan ribbon, you can easily access everything related Tasks (Gantt, Open 

WBS, create Tasks, Subtasks, Milestones, access the Task Info and get basic Project Statistics 

instantaneously). To edit the Task Info through a dialog, do the following steps: 

1. Click the Plan ribbon tab.  

2. From the Task group, click the  Information button.  

Here you can access the General Information about the task, you can set its predecessors, 

which in the same time means setting dependencies and add the necessary resources.  

 

Figure 148. Task Information dialog 

Work with Constraint Dates 

Constraint means restrictions. While creating a project plan you can set a restriction on task’s 
start or finish date. This means that some specific task must start on or finish no later than a 

particular date.  

There are three types of constraints: 
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 Flexible constraints 

 Semi-flexible constraints 

 Non-flexible (Inflexible) constraint 

Flexible constraints doesn’t content specific date. Using these constrains, users can start the 
project tasks as early as possible or as late as possible as long as the tasks with constraint dates 

ends before project’s finish date. 

Semi-flexible constraints requires an association with dates that controls the earliest or latest 

start or finish date of the task. Tasks with semi-flexible constraints can finish at any time as 

long as it meets the start or finish deadline of the project plan. 

Non-flexible constraints requires an association with dates that controls the start or finish date 

of the task. These constraints are used when there are many external factors that are associated 

with the task/project plan. 

All constraints that are implemented in iMindQ are presented in the table below. 

Symbol Type Name Description 

 SNET Start No Earlier Than Schedules the task to start on or after a 

specified date. Use this constraint to ensure 

that a task does not start before a specified 

date 

 FNET Finish No Earlier Than Schedules the task to finish on or after a 

specified date. Use this constraint to ensure 

that a task does not finish before a certain 

date 

 SNLT Start No Later Than Schedules the task to start on or before a 

specified date. Use this constraint to ensure 

that a task does not start after a specified date 

 FNLT Finish No Later Than Schedules the task to finish on or before a 

specified date. Use this constraint to ensure 

that a task does not finish after a certain date 

 MFO Must Finish On Schedules the task to finish on a specified 

date. Sets the early, scheduled, and late finish 

dates to the date that you type and anchors 

the task in the schedule 

 MSO Must Start On Schedules the task to start on a specified date. 

Sets the early, scheduled, and late start dates 

to the date that you type and anchors the task 

in the schedule 
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Set Constraint Date 

iMindQ works with Semi-flexible and Non-flexible constraints. Constraint Date and 

Constraint Type are located in the Task Information window, in the General tab. Setting 

Constraint Date and Type to the task is very easy and it can be done in several steps: 

Select the task in the Gantt Chart. 

Double-click on the cell in order to open the Task Information window. 

In the General tab click on the Constraint drop-down list to assign a Constraint type to the 

task. 

In the General tab click on the Date drop-down list to assign a Constraint date to the task. 

 

Get basic Project Info 

Once you have created/planned all your tasks needed for finishing a project successfully. You 

can open the Project Statistics dialog from the ribbon PlanProject group.  

 

Figure 149. Get basic Project Info 

 

Importing project plan with Constraint dates in iMindQ® 

If you import project plan created in Microsoft Project and the project plan contains 

Constraint Type and Constraint date, then the same information will be imported and 

presented in iMindQ. The symbol for Constraint Type in the Indicator column will appear in 
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front of the task name and in the Task Information window you can view the necessary 

information. 

 

Late Tasks 

Project plan is a massive structure that has many tasks, involves number of resources and has 

costs. Very often project participant, projects managers and team leads need information that 

comes from a different part of the project plan. For example, they need general info for the 

project’s schedule and the milestones, or they need to view which tasks can harm the project’s 
output. Thus, iMindQ® has one category of marking tasks that present certain task’s status in 
the project plan. 

Late tasks are those tasks that are not 100% when the status date is past the task’s finish date. 

 

To view which tasks are late, just click on the Late Task button in the “Plan” ribbon and the 
tasks that are not fulfilling the criteria above will be colored light red, at is presented on the 

image below. 

 

Figure 150. Late Task 

Short Example: One task has duration of 5 days. That means that every day, assigned resource 

must complete 20% from the task. Status date is at the 5th day (or after the 5th day). 
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That means that at the end of the 5th day, 100% of the tasks must be completed. If this is not 

a case, then the task will be colored red. 

 

 

Change Working Time 

Project plans are scheduled according calendars. They defined the working days in the week, 

how many hours project participant will be spend on daily basis and etc. The “Standard” 
calendar is defaulted calendar in iMindQ®, with working days from Monday through Friday, 

from 8 A.M. to 5 P.M. The other two calendars that are available for scheduling are: 

 Night Shift 

 24 Hours 

But sometimes, you need to modify it. You need to change the working hours, to make 

particular day non-working or to set the working weeks according the project needs. For this 

case you will use the “Change Working Time” feature, located in the “Plan” ribbon. Using 
mentioned feature, you can: 

 Insert Exceptions 

 Make custom Work Weeks 
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Exceptions 

Exception days are days in the working week with different working time as the usual one. 

Resource’s vacation, national holidays, time off days can be considered as exceptions for the 

project plan and must exists in the project calendar. It very important for the project manager 

to take them into consideration when estimates the project deadlines. 

 

Exception day with specific working time 

In iMindQ®, by default, all exception days are created as non-working days. If you want to 

make them working days, but with different working times, perform the following steps: 

 From the Plan ribbon click on the “Change Working Time” icon  

 Once the new dialog is opened, choose the base calendar for which you want to 

insert exception day (presented on the image below with number 1.) 

 Insert the name of the exception along with the Start and Finish dates (presented 

on the image below with number 2.) 

 Once the exception is created, click on the “Details” button (presented on the image 
below with number 3.) 

 

 

Figure 151. Change Working Time dialog 
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The newly created exception day will be colored blue in the calendar preview. Next step is to 

define the working hours for this particular day. 

 

Figure 152. Details for Exception Day 

1. In the “Set working times for Exceptions” section click on the “Working times” 
radio-button   

2. Inserts the working time using the “From” and “To” column in the table. 
Exception days as repeating holidays 

National holidays are days with recurrence pattern. They are not included in the application’s 
calendar, but you can add them manually. 

1. Repeat the first 3 steps from the previous section.   

2. In the “Recurrence pattern” section select the recurrence of the holiday. 
3. In the “Range of recurrence” pick how often the holiday repeats during the 

project time-frame. 

 

Work Week 

Based on the selected project calendar, the work schedule for all project’s tasks varies. Their 
schedule depends from the working days and the working times. iMindQ® provides three 
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base calendar that can be used as templates for the project plans, with the following working 

days and times: 

 Standard – The Standard calendar reflects the traditional western work schedule: 

From Monday to Friday, from 08:00 A.M. until 5:00 P.M., with and hour break 

between 12:00 A.M. and 1:00 P.M. 

 Night Shift – The Night Shift calendar is scheduled from Monday night to Saturday 

morning, from 11:00 P.M. until 08:00 A.M., with and one hour break from 03:00 A.M. 

to 04:00 A.M. 

 24 Hours – The 24 hours calendar characterizes with continues work, 24 hours a day, 

7 days a week. 

Very often, project plan required modifications of the working times, working days. You can 

customize them using the steps that are described below: 

1. From the Plan ribbon, click on the Change Working Time icon  

2. Once the new dialog is opened, choose the base calendar for which you want to 

insert custom week (presented on the image below with number 1.) 

3. Click on the "Work Week" tab (presented on the image below with number 2.) 

4. Insert the name of the exception along with the Start and Finish dates 

5. Once the exception is created, click on the “Details” button (presented on the 
image below with number 3.) 

 

Figure 153. Change Working Time dialog 
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6. The newly created exception day will be colored yellow in the calendar preview. 

Next step is to define the working hours for this particular day. 

 

Figure 154. Details for Work Weeks dialog 

7. In the “Set working times for this work week” section click on the each day from 
the week and insert the specific working time. 

If you need to make some day nonworking, then select the “Set days to nonworking time” 
radio button. 

 

Differentiate and visualize tasks in the Gantt Chart by coloring the Task 

Bars  

In order to better differentiate and visualize the tasks from the map space into the Gantt Chart 

view, iMindQ® enables you colorize the task bars with one single click. The main rule is the 

specific type of task represented in the Gantt Chart View, with appropriate symbol, to inherit 

the fill color of the adequate task in the map space. Each task in the map space, that has white 

fill color or the fill color is set to None, than these tasks in the Gantt Chart View shall be 

represented in the Gantt Chart View with the predefined style for each type of task accordingly.  

The transparency of a certain Fill color applied to a task, will be ignored and the task bar in the 

Gantt Chart View shall be colored with the basic Fill Color to which the transparency was 

applied. Do the following steps:  

1. Click on the Plan ribbon tab.  

2. From the Project group, click on the Color Gantt Chart  button.  
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Here is an example of how your tasks will be visualized in the Gantt Chart View, after choosing 

the option to use the Color Gantt Chart option.  

 

Figure 155. Colored Task Bars in the Gantt Chart View 

 

Manage the visibility of desired Task Information 

At different times, you need different Task Information to be visible in the map space, 

depending for which purpose you use specific Task Information. You can manage whether the 

Task Information shall be visible or not, and which specific information shall displayed within 

the task in the map space.  

To display the needed Task Information in a specific document, do the following steps:  

1. Click on the Plan ribbon.  

2. From the Project group, click on the Show Task Info button.  

To manage which Task Information shall be visible within one task in the document, follow 

these steps: 

1. Click on the Plan ribbon.  

2. From the Project group, click on the Show Task Info dropdown menu. 

3. From the dropdown menu, click on the Display Options feature. 

The Display Options dialog shall open, and here the user can select which Task Information 

shall be visible and can also specify what shall be the default value for the Priority.  
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Figure 156. Display Options 
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Import from Microsoft Excel 

Selecting the “Excel” icon in the from the Import group in the Integrate ribbon, you will import 

the content of the document created with Microsoft Excel 2007/2010/2013.     

You can import data from an Excel file in iMindQ® in several ways. First thing you need to do 

is open an Excel file in IMindQ®, with the help of Excel Importer Panel. To import an Excel file, 

perform the following steps: 

1. Go to the Exchange Ribbon Menu and choose ‘Excel’ from the ‘MS Office’ Group. 

2. Click the button  from the Excel Importer Panel. 

3. Select a specific Excel file. 

4. Click ‘OK’.  
 

 

Figure 157. Excel Importer Panel 

You can insert data from the imported file in a map, by using one of the following 

functionalities.  

 Import as Topics 

 Import as Outlined 

 Import as Spreadsheet 

 Import as Custom Property 

 Import Topics with Properties 

Import as Topics 

The functionality ‘Import as Topics’ uses the following logic: each value in a new column is a 

subtopic to the value in the predecessor column, but in the same row.  

Import and Export map information 
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For example, we can use the data from the following table to show you exactly how selected 

data will be inserted in the map.  

Job Title  Mid-West States  North-East States 

Computer and 

Information Scientists, 

Research 

$ 39.1 $ 47.95 

Computer Programmers $ 35.19  $ 28.07 

Table-1.  

Do the following steps: 

1. Select a topic in the map, to which you would like to insert the selected data. 

2. Select a column/or columns with data from the Excel Importer. (In our example, 

we will use selection of three columns). 

3. Click ‘Import as Topics’ from the dropdown menu in the bottom of the Excel 

Importer Panel. 

Note: You can also choose this functionality from the context menu on right click to the made 

selection.  

 

Figure 158. Example 1 for ‘Import as Topics’ 

Import as Outlined 

The functionality ‘Import as Outlined’ uses different logic from the previous functionality. To 

better present how this functionality inserts the data in the map, we will use data from Table-

2 and Table-3.  

 

 A B C 

1 1   

2  1.1.  

3   1.1.1. 

4 2   

5  2.1.  

6   2.1.1. 

7 3   
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8  3.1.   

9   3.1.1. 

Table-2. 

 A B C 

1 1 1.1. 1.1.1. 

2 2 2.1. 2.1.1. 

3 3 3.1. 3.1.1. 

Table-3.  

Here are the rules that apply to the logic of this functionality, which you need to know in order 

to properly insert the wanted data in the map.   

 The data from the first column in Table-2 will be inserted as subtopics, with level 

X, to the selected topic in the map;   

 Each cell with data within one column, should be the only cell in the specific row, 

filled with data.   

 In order to present a child topic (with level X+1) to a certain topic with level X, 

the data should always start in the successor column and in the successor row.  

To insert data in the map with the functionality ‘Import as Outlined’, perform the following 

steps: 

1. Select a topic in the map, to which you would like to insert the selected data. 

2. Select data from the Excel Importer. (In our example, we have selected the data 

from Table-2)  

3. Choose ‘Import as Outlined’ from the dropdown menu in the bottom of the 
panel. 

Note: You can also choose this functionality from the context menu on right click to the made 

selection.  

 

Figure 159. Example 2 for ‘Import as Outlined’ 
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If data are not outlined as the rules specify, then any selection from Table-3 will only insert 

the data from the first column selected from the table and will be displayed in the map as 

subtopics to the selected topic in the map.  

The data that are in the same row as the data from the first selected column, won’t be inserted 
in the map at all.   

Import as Spreadsheet 

You will be able to insert the selected data from panel as a spreadsheet in the selected topic. 

You can do this in two ways: from a dropdown menu in the bottom of the panel or from a 

contextual menu on right click of the selection.  

Do the following steps: 

1. Select a topic in the map, to which you would like to insert the selected data. 

2. Select data from the Excel Importer. (In our example, we have selected the data 

from Table-2)  

3. Choose ‘Import as Spreadsheet’ from the dropdown menu in the bottom of the 
panel. 

Note: You can also choose this functionality from the context menu on right click to the made 

selection.  

We used the data from Table-1 to insert data in a topic as spreadsheet. See the result in Figure 

 

Figure 160. Example 3 for ‘Import as Spreadsheet’ 

Import as Custom Property 

There are two business rules connected with this functionality. You cannot import data as 

custom property if you have selected more than two columns or only one column. The latter 

applies only when you haven’t defined the property identifiers. 

This functionality allows you to insert the selected data in the form of Property Name/ID in a 

left-side column and the property values in right-side column. In the case when there is no 

data in the table that are marked as property id’s, the selected data of two columns will be 

inserted as the default rule: 
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Property ID Property Value 

 

We also allow you to define which data from the panel will be considered as property 

identifiers. This can be done be selecting the data that you want to define as property id’s and 

right click on the selection ‘Mark as property identifier’.  

 

Mark as Property Identifier 

You can mark data from one column or one row as property identifiers. To insert data from 

the panel as values, they will have to match the marking.  

 

If you’ve marked data from one column as property identifiers, than you have to select data 

from a column that fits the range of the marking.  

If you’ve marked data from one row as property identifiers, than you have to select data from 
a row that fits the range of the marking.  

To mark specific data as property identifiers, do the following steps: 

1. Select data from one row and several columns. 

2. Right-click on the selection and choose ‘Mark as Property Identifier’.  

To import data as custom property to a selected topic in the Map, perform the steps: 

1. Select a topic in the map.  

2. Select data from the panel that fall into the range of the marked property 

identifiers. 

3. Right-click on the selection and choose ‘Import as Custom Property’.  

Note: You can also choose this functionality from the context menu on right click to the made 

selection.  
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In the case when no marking is done, then any data selected from two columns can be 

imported as custom properties. You can select data from two consecutive columns or from 

two different columns.  

Import Topics with Properties 

For this functionality you will need to mark two things: Topic identifiers and Property Identifiers. 

You can mark data as Topic identifiers only by columns. This column will be the last left column 

from the data that you would like to insert in the map. You can see here how to mark data as 

Property Identifiers.  

Mark as Topic Identifiers 

In order to mark data as topic identifiers, you need to do the following: 

1. Select data from a specific column.  

2. Right-click on the selection and from the contextual menu choose ‘Mark as 

Topic Identifier’.  

To better explain this functionality, we will use the data from Table-1, but with marked Topic 

and Property Identifiers.  

Job Title  Mid-West States  North-East States 

Computer and 

Information Scientists, 

Research 

$ 39.1 $ 47.95 

Computer Programmers $ 35.19  $ 28.07 

 

Once the marking is done, to insert the data in the map do the following things: 

1. Select a topic in the map. 

2. Select data from the panel that fall into the range of the marked data as topic 

and property identifiers. 

3. Right-click on the selection and choose ‘Import as Topic with Properties’.  

Note: You can also choose this functionality from the context menu on right click to the made 

selection.  

The grey color of the cells from this table signifies the data marked as Topic Identifiers, and 

the red color signifies the data marked as Property identifiers. After performing the previous 

steps, you can see the result in Figure 161.  
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Figure 162. Example 4 for ‘Import as Topics with Properties’ 

Import 

Import from Microsoft Project 

In iMindQ®, there will be no need to have MS® Project installed on your computer, in order 

to import a Microsoft® Project (.mpp) file.  

By selecting the “Project” icon from the Collaborate group, in the Exchange ribbon, you will 

import the content of the document created with Microsoft Project 2007/2010/2013.     

The import process is very simple. When the appropriate feature is selected, the “Open” dialog 
starts up, from where you can specify the location of the desired file. After selecting the file, 

the imported project document will be imported in a new map.  

Import an OPML file  

An OPML (Outline Processor Markup Language) file can be opened by choosing the Import 

from OPML option in the Collaborate group, positioned in the Exchange ribbon. iMindQ® will 

present the outlined content from the OPML file as a mind map. If the file contains notes for 

a certain topic, the text will be presented as plain text in the Notes Editor. Only one hyperlink 

can be displayed per topic, when importing an OPML file.  

Import HTML interactive mind map 

In order to import a HTML interactive mind map, you can use the option available in the Import 

submenu in the File Menu options or use the Import HTML map option in the Exchange ribbon. 

This option is useful when you want to view the feedback of other coworkers or team members 

which gave or added a constructive feedback to the map that you created or you might add 

your own review and comments and send it back to the creator, exported as HTML interactive 

file format again. 
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Export 

Export to Microsoft Project 

Selecting the “MPP” icon in the from the Collaborate group in the Exchange ribbon, you will 

export the content from the iMindQ® map into Microsoft Project 2007/2010/2013 

document.     

The import process is very simple. When the appropriate feature is selected, the “Save” dialog 
starts up, from where you can browse the desired location where the file will be saved. 

Export as HTML interactive Map 

When you export a map as single page, HTML interactive map, you have the advantage to do 

several things with it:  

 View the branches in depth; 

 Position the branches where you want; 

 Zoom in and zoom out;  

 Play the creation of the map; 

 Share your mind map on your blog, website, and in social media.  

In order to export the map as HTML interactive map, do the following steps: 

1. Click on the Exchange ribbon.  

2. From the Export group, click on the HTML Map button.  
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Export as HTML Web Page 

When you export a map as HTML web page, in the exported file you will get an outline of the 

content of the map, plus an image of the exported map.  

In order to export the map as HTML interactive map, do the following steps: 

1. Click on the Exchange ribbon.  

2. From the Export group, click on the HTML Web Page button.  

Export to OPML file  

An iMindQ® ma will be exported as an OPML (Outline Processor Markup Language) file can 

be exported, by choosing the Export to OPML option in the Collaborate group, positioned in 

the Exchange ribbon. The OPML file will contain the outline of the mind maps created in the 

iMindQ® file. Have in mind that only the first hyperlink in a topic will be exported in the OPML 

file. The text in the Notes editor will be exported as plain text.  

Export to ODT file  

The map content and the supported topic elements can be exported to an ODT (Open 

Document Text) file format, which will contain rich-text content of the map and topic elements’ 
content that are supported with the export of the map in this format.  

To export the map as ODT, you will need to click on the Exchange ribbon tab, and from the 

Export group, choose the ODT export option. There is one more way to export the map to ODT 

file format, by going to the Import/Export submenu in the File Menu, and from the Export Tab 

choose the Export to ODT functionality. 

Export as .pdf document 

Selecting the “PDF” icon in the from the Collaborate group in the Exchange ribbon, you will 

export the content from the iMindQ map into .pdf file format.     

The import process is very simple. When the appropriate feature is selected, you have to set 

the exporting settings. Once you are done with this dialog, the “Save” dialog starts up, from 
where you can browse the desired location where the file will be saved. 

Export as image 

Selecting the “Image” icon in the from the Collaborate group in the Exchange ribbon, you will 

export the content from the iMindQ® map into .jpg, .svg or .png file format.     
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The import process is very simple. When the appropriate feature is selected, the “Save” dialog 
starts up, from where you can browse the desired location where the file will be saved. Before 

saving the file you can set the image size and quality. 

Languages 

With this feature the need of reinstalling the application in order to change the application 

language has been avoided. You can now switch the application language by simple click on 

the desired language and restarting the application. 

There are five available languages: English (default), German, French, Spanish and Portuguese. 
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Printing 

In order to manage the map or the project plan effectively, you will often need to share 

information. The usual way for doing this is to print an entire map/project plan or a specific 

parts such as map parts or the Gantt Chart view. When using Print function, the printout will 

be the currently selected view in iMindQ®. 

The Print tab contains the following sections: 

 Print – Start printing the mind map. 

 Copies - Spin box for inserting the number of printing outcomes of the mind 

map. 

 Printer - Drop - down list containing all available printers. 

 Page Setup – Pops up the Page Setup dialog, where you can adjust the printout 

settings, such as Paper size, Orientation, Margins, Header and Footer. 

 Settings: 

o Page Orientation 

o Paper Size 

o Print Mind map, Gantt chart or Notes 

You can start the Print function from the File menu File ->Print, from the Standard toolbar by 

pressing on the icon or from the Standard Quick bar. 

 

Page Setup 

After selecting the Page Setup option from the File menu, new dialog form (Page Setup dialog 

box) will pop up allowing you to make the necessary preparation before printing. In terms of 

selecting the page orientation, paper format, inserting header and footer and etc. 

The Page Setup dialog box has a tab structure and contains 4 tabs: Page, Margins, Header and 

Footer. 

Page Tab 

Page tab, presented on the figure below, allows you to adjust the page layout before printing 

project information. You can select whether the project printout will be Portrait or Landscape, 

printed on A4, A3 or Letter paper size, etc. Default values are: Landscape and A3 for Page 

Orientation section and resolution of 600 px.1.27 cm for all margins in the Margins section. 

Printing 
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Figure 163. Page tab 

Margins Tab 

The Margins tab allows you to defining the space where the map will be displayed as well as 

the position of the map on the paper. The default values are 1 inch for the Top and bottom 

margin and 0.75 inches for Left and Right Margins. The map is horizontally and vertically 

centered on the page. 

 

Figure 164. Margin tab 



 

 

 

 

 

157 iMindQ User Manual for Mac 

Header Tab 

Many companies have a company template(s) when printing official documents. One example 

for printing template is to have the name of the project in central position, company logo on 

the left side of the paper and the project manager name on the right side. This information 

should be placed in the upper part of the paper. Using the Header tab can help you to establish 

the company’s policy when mind maps in iMindQ®. The look of the Header tab is presented 

in Figure 165. 

Header tab has 3 tabs: left, center and right that refers to the positions of the inserted text in 

the printing paper. In the fields you can enter your own text or insert previously prepared 

project information text such as: page number, total page number, date, time and file name. 

 

Figure 165. Header tab 

Footer tab 

The look of the Footer tab, Figure 166, is identical to the Header tab. You can insert various 

information that will be placed in the lower part of the printing paper, under the project’s 
legend. 
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Figure 166. Footer tab 

Print 

To manage a mind maps effectively, you may need to communicate map information to a 

variety of people. With iMindQ®, you can print maps and charts that present the exact 

information you want. 

The process of printing the information you need can be as simple as clicking a button or as 

refined as customizing and previewing the existing views. No matter how simple or refined the 

process, printing a map or chart consists of essentially the same steps: 

 Select the map or chart that best presents the information you want – If a 

predefined map or chart does not meet your exact needs, you can apply different 

styles. 

 Make display changes to the map or chart – For example, you may want to scale 

information to fit on a single page. 

 Preview a map or chart before it is printed – Previewing a view or report can help 

you verify content and display changes you made so you can adjust them again 

if necessary. 

 Print the map or chart – To make printing as efficient as possible you can specify 

the options you want. For example, you can print a range of pages (defined by 

page numbers or dates), suppress blank pages, and print multiple copies. 
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You can make changes to the way a printed view or report looks by specifying page setup 

options such as page orientation, scale, or paper size. 

Once you open the Page Setup dialog, you can follow the steps below to specify the page and 

other printing options for a view or a report. Note that some of the options in the Page Setup 

dialog available for views may not be available for the reports. Some options may differ 

between different views as well: 

Click the Page tab in the Page Setup dialog. 

1. To change page orientation, under Orientation, click Portrait (vertical) 

or Landscape (horizontal). 

2. To scale pages, under Scaling, click Adjust to, and then type the percentage at 

which you want information to appear on your printed pages in the% normal 

size box. 

3. To adjust page fit (some views only), under Scaling, click Fit to, and then specify 

the number of pages you want in the pages wide by and tall boxes. 

4. To change the paper size, click the paper size you want in the Paper Size box. 

5. Click the Margins tab. 

6. In the Top, Bottom, Left, and Right boxes, type or select the new margin settings 

7. To place the map in the center of the page, select 

the Horizontally and Vertically check boxes in the Center on page frame. 

8. Click on the Header tab 

9. To select the font of the Custom header, click on the Font button 

10. To insert an image in the Custom header, click on the Image button 

11. To select the alignment of the header’s text or image, click on the Right, 

Center or Left  button 

12. Click on the Footer tab 

13. To select the font of the Custom header, click on the Font button 

14. To insert an image in the Custom footer, click on the Image button 

15. To select the alignment of the footer’s text or image, click on the Right, 

Center or Left button. 

Before printing a map or chart, in addition to the page setup options, you can specify print 

options such as the printer and its properties, the print range for pages, the number of copies, 

and the date range. 

1. In the File tab, click on the Print sub-tab. 

2. From the Printer drop-down menu select the appropriate printer. 

3. In the Settings portion of the Print sub-tab select the page orientation, paper size 

and the map’s part (mind map, outline or notes). 
4. To print the map or chart click on the Print button.  
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Create a Calendar Event  

If you want to plan and organize your daily events from scratch, you can do that in a To-Do 

List or a Personal Planner mind map within iMindQ®. These created events will be directly 

added to the Calendar App and they will constantly be synchronized both in iMindQ® and in 

Calendar App. So anywhere you go, you will stay up-to-date with upcoming events and any 

changes to it.  

In order to create a Calendar Event, do the following steps:  

1. Click on the Exchange Ribbon tab.  

2. From the Collaborate group, click on the Calendar  dropdown menu.  

3. Click on the Create Calendar Event option.  

Set the desired properties for the Calendar Events in the Create Calendar Event dialog as in 

the image below.  

 

Figure 167. Create Calendar Event dialog 

The created calendar event is added as a new topic added to the selected topic.  

Plan and organize your daily activities  
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Figure 168. Calendar Event  

If you want to edit the properties of the Event, click on the Calendar icon  in the event, 

positioned on the right side of the title of the topic. The Edit Calendar Event dialog will open 

and after you change the desired information, click on the Update button.  

 

Figure 169. Edit Calendar Event dialog 

Import Calendar Events   

If you want to create a dashboard with planned personal events and meetings, and always stay 

up-to-date with any changes and be reminded on time, use the Calendar options in iMindQ®. 

You can create and plan event within iMindQ® or you can import already created events from 

the Calendar application.  

In order to import Calendar events to a topic in iMindQ®, do the following steps:  

1. Click on the Exchange Ribbon tab.  
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2. From the Collaborate group, click on the Calendar  dropdown menu.  

3. Click on the Import Calendar Events option.  

A dialog for importing Calendar Events opens up, where you can filter the events by different 

event properties and criteria. From the listed events, select the specific event that you would 

like to import to a topic in iMindQ®.  

 

Figure 170. Import Calendar Events dialog 

If you want to edit the properties of the Event, click on the Calendar icon  in the event, 

positioned on the right side of the title of the topic. The Edit Calendar Event dialog will open 

and after you change the desired information, click on the Update button.  

The information will be automatically synchronized in both application: Calendar and iMindQ®.  

Create a Reminder  

If you want to add reminders for specific tasks and assignments that you need to finish on 

time or need to do something immediately in a specific moment, you can do that within 

iMindQ®. You can create a reminder to a task in the map, or different actions, by using the 

Reminders integration.  

In order to create a Reminder, do the following steps:  

1. Click on the Exchange Ribbon tab.  

2. From the Collaborate group, click on the Reminders  dropdown menu.  
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3. Click on the Create Reminder option.  

Set the desired properties for the Reminder in the Create Reminder dialog as in the image 

below.  

 

Figure 171. Create Reminder dialog 

The created reminder is added as a new topic added to the selected topic.  

 

Figure 172. Reminder in iMindQ®  

If you want to edit the properties of the Reminder, click on the Reminder icon  in the topic, 

positioned on the right side of the title of the topic. The Edit Reminder dialog will open and 

after you change the desired information, click on the Update button.  

The information will be automatically synchronized in both application: Calendar and iMindQ®.  
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Figure 173. Edit Reminder dialog 

Import Reminders  

When you already planned specific reminders in a Reminders list, whether its custom or default 

list, and when you want to add them to a topic in a mind map, you have the option to import 

these reminders from Reminders application into iMindQ®.  

In order to import Reminders to a topic in iMindQ®, do the following steps:  

1. Click on the Exchange Ribbon tab.  

2. From the Collaborate group, click on the Reminders   dropdown menu.  

3. Click on the Import Reminders option.  

A dialog for importing the reminders opens up, where you can filter information by different 

reminders’ properties and criteria. From the listed reminders, select the specific ones that you 

would like to import to a topic in iMindQ®.  
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Figure 174. Import Reminders dialog 

If you want to edit the properties of the Reminder, click on the Reminder icon  in the topic, 

positioned on the right side of the title of the topic. The Edit Reminder dialog will open and 

after you change the desired information, click on the Update button. 

The information will be automatically synchronized in both applications: Calendar and 

iMindQ®.  

 


